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1. INTRODUCTION

1.1 PURPOSE

This document contains general information that will be useful to know before using Solomon
Isolation Database Application.

1.2 APPLICATION OVERVIEW

Solomon Isolation Database is a software program that is used to generate Isolation
Statements, Specific Isolation Requirements, Permit to Work in alignment with FMG Standard
and Procedure.

MAJOR FEATURES
e Generate Isolation Statements
e Generate Specific Isolation Requirements (SIR)
e Generate Permit To Work

For further information please refer to Document 100-PR-SA-1003 (Permit to Work Procedure)
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2. INSTALLATION

2.1 Installation Guideline

The following procedure will step you through the installation process.

Instruction

1 | Install all the pre-requisites files located in:

J:\Cong
Nguyen\PermitToWorkDatabase\Prerequisites
Files

Once all files have been installed, restart the
computer and proceed to the next step

5. Brother label Printer
5;_.!' 1. AccessDatabaseEngine
= 2.5QL5ysClrTypes
7 3. ReportViewer
19 4. SgllocalDB
ﬂ 6. NDP46-KB3045560-Web

2 | Install FMGPermitToWork Application

J:\Cong
Nguyen\PermitToWorkDatabase\FMGPermitToWo
rk

Once the application is installed, proceed to the
next step

Application Files

IsolationTags

Prerequisites Files
T} FMGPermitToWork

3 | Run FMGPermitToWork from your Desktop

&
IV GhEr

4 | When FMGPermitToWork initialises for the first
time, the following error dialog will appears. Click
OK to acknowledge.

- A

Exception

v | ExecQuery Error:
@7 A network-related or instance-specific error occurred while establishing
a connection to SQL Server. The server was not found or was not

accessible. Verify that the instance name is correct and that SQL Server
is configured to allow remote connections, (provider: Named Pipes
Provider, error: 40 - Could not open a connection to SQL Server)

1
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file://fmg.local/perth/fmg_data/Cong%20Nguyen/PermitToWorkDatabase/Prerequisites%20Files
file://fmg.local/perth/fmg_data/Cong%20Nguyen/PermitToWorkDatabase/Prerequisites%20Files
file://fmg.local/perth/fmg_data/Cong%20Nguyen/PermitToWorkDatabase/Prerequisites%20Files
file://fmg.local/perth/fmg_data/Cong%20Nguyen/PermitToWorkDatabase/
file://fmg.local/perth/fmg_data/Cong%20Nguyen/PermitToWorkDatabase/
file://fmg.local/perth/fmg_data/Cong%20Nguyen/PermitToWorkDatabase/

Instruction

5 | Select Settings > Connect to SQL ) FMG Permit To Work

File [ Account ﬁEv:M i Settings | About  Online Discussion Board
FORTESCUS. Srmetosat IORK SYSTEM

Connect to Local SQL

Online Mode Offline Mode by
KV_T Access Level
6 | A new dialog will appears. Select a Server then z EMG Pecmit To Work =
. . - Select Server
click Connect to continue e e S
F 1
Salect A Server -
FT_Diatabase
_Dat:
Online Mod: Pgl_g!mu_
T e
PORT_TRAINING
7 | The Application will self-restart a EMG Parmit Tn Wirk
File &Am = Select Server
MNew Server...
F FMGPermitToWork
Select A Server: KV. b4
= Connected
- Cancel
v TRAIN T

Application will now restart

= FMG Permit To Work = =

File [, Account [ Event i Settings  About  Online Discussion Board

FORTESCUE PERMIT TO WORK SYSTEM

Breakdown v

Shutdown

UserName
Online Mode View Evert Role Level
KV_TRAINING Access Level

-

~

Server Name

The Application is now connected to KV_TRAINING database

END OF PROCEDURE
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3. SOFTWARE LAYOUT

3.1

Software layout

FMGPermitToWork consists of 3 types of working events: Breakdown, Shutdown and
Templates. Below are the main differences:

Breakdown Event

Shutdown Event

Templates

Isolation Statements

No lockbox numbering
restriction. Different
Isolation Statements can
be allocate to the same
Lock Box

Each Statement has a
unique Lock Box

Lock Boxes are not
required

SIR

Not applicable in this mode

SIR are generated from
Work Packs

TSIR Isolation Points are
referenced to Isolation
Statements’ Lockbox

Work Packs not required.

Isolation Points don’'t have
Lock Box Number

Permit to Work Work Permits are Work Permits are N/A
generated from Isolation generated from TSIR
Statement
Work Orders are not
required
Other Features Outlook Integration Shutdown Planning Tools N/A
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4, BREAKDOWN EVENT

4.1 Create a new Breakdown Event

1. From the Main Screen. Login in with your credentials

2. Click on Event > New Event to create a new Event

z FMG Permit To Work - olEl

File &Accaunt Event h/S:ttings About  Online Discussion Board

New Event

FOR weex |[RMIT TO WORK SYSTEM

Shutdown v
Shutdown
UserName: Cong
Online Mode View Event Role Level: administrator
TrainingDatabase Access Level: 4

3. Type in the Event Name, its Description and select an Event Type. Click OK to proceed.

%) Create New Event H n

Event Name: | BreakdownA17 |

Evert Description: | Breakdawn Aprl 2017 | Mew Event Created

Event Type: [ ] Shutd

[] Templates ok
0K || Cancdl
4. From the Main Screen, Select “BreakdownA17” Event
= FMG Permit To Work = o “
File a Account Event & Settings  About  Online Discussion Board
FORTESCUE PERMIT TO WORK SYSTEM
| Breakdown v]
Breakdown
Online Mode View Event Role Level:  administrator
TrainingDatabase Access Level: 4
5. Click View Event to view the event details
a FMG Permit To Work - 8
File &Account Event & Settings  About  Online Discussion Board
FORTESCUE PERMIT TO WORK SYSTEM
| Breakdowna17 vl
UserName:
Online Mode Fiole Level:
TrainingDatabase Access Level:
Event Type
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4.2 Create New Isolation Statement

1. From the Event Details Screen.

Select ISOLATION STATEMENTS > Actions > New Isolation Statement

]
| (2 ISOLATION STATEMENTS || (£] PERMIT TO WORK
i |

2. A new form will appears. Fill in all the required Fields:

1. Select Plant Area
\ 1D:  BreakdownA1745-000001

2. Type in the Statement's Description T e >

3. Select s Lock Box Descrpton” [EEETHIVININEEE |
T S vl

4. Type in any lsolation Information \ e [ORAFT vl
alation Condeon / knformation: |

FLTERS.
) ) ) Choses Fiter: SHOW ALL AVAILABLE ISOLATION POINTS
5. Filter Available Isolation Points by Equipment ID: — e |
Avaiotie Ports
Equpmenthiame loctonPort ~
3 ]
CONVEYOR SUMP PUMP 1 | 400V SUBBOTMCCO1-SPE01CVB02
ONVEYOR SUMP PUNP 2 400V SUBBO1-MCCO1-SPB02CVBR2
C/W WINCH MAIN ISOLATOR 400V SUBY01MCCO1 CVS02WHOT
CYI51 WINCH CHAINS 1 cvist 1
TAL BRAKE 400V SUBS01-MOCO1CVBO18KLOT
DRIVE 1 VS0 LV AUKLIARY SUPPLY 400V SUBS01-MCCO1CVBOT DRIVE
DRIVE 2VSD LV AUKLIARY SUPPLY 400V SUBS01-MCCO1CVBOT DRIVEZ
CAW WINCH MAN ISOLATOR 400V SUBE01-MCCD1CVBOTWHOT
DRIVE 1 VS0 LV AUNILIARY SUPPLY 400V SUBS01-MCCO1CVB02 DRIVET
CAN WINCH MAN ISOLATOR 400V SUBS01MCCOTCVB02WHOT
FIRE WATER PUMP SYSTEM 400V SUBS01-MCCOFPP-901
TURNOVER PIT WATER BOOSTER PUMP 400V SUBSOTMCCOTPUBDI-SKED!
< >
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3. Filter the Isolation Points by Equipment ID or Description. Multiple points can be
added to the list at the same time:

ID:  BreakdownA1745-000001

Plart Area®  FMG-SM-STOCKYARD "l

Descrion:* BREAKDOWN WORKS - CVB02 |

Lock Bax = 1 v

Staws* | DRAFT v

solation Candition / rformtion:
FILTERS 2. ADD the Points to the selected List
Chooss Fiter: SHOW ALL AVAILABLE ISOLATION POINTS M
1. Selact Isolation Peints (s) cven2 vsD

>

0K Cancel

4. Sort the Isolation Points by clicking on header, or drop and drag to a specific position
in the list. The Isolation Sequence appears on the statement starts from top to bottom

(1,2,3..)
ID: BreakdownA1745-000001
Part Aea* | FMG-SW-STOCKYARD v]
Descption:” BREAKDOWN WORKS - CVa02
Lock Bax * 1 v
Siaus | DRAFT v)
lsolation Conditon / Information: Drop & Drag Points to
Re-Arrangs the
FILTERS Isalation Point
Choose Fiter: SHOW ALL AVAILABLE ISOLATION POINTS ::m"i::ei-:‘:&"‘
cvenz ||vsD

Selected Points.
1 3 «  IsolationPort
_m 11KV CB VSDO01CB SUB801-AD3ICY
Add ALL 5> CVB02 11KV CB VSDO1 CB (BUS SHUTTER)

ok o

5. Click OK to Create this statement
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6. The new statement is now listed in the Event Details page. Double click on the item to

Preview

File b WorkGroup | g Administration  Audit Trail  Reports  Event Ovenview (i) Help

(2] PERMIT TO WORK

3 ISOLATION STATEMENTS

Actions | 4 Impont ‘B Epot | Preview (LhjPint  LockBox Coversheet - %

7. To Edit the statement. Highlight the item on the list, Select Actions > Edit Statement

End of Procedure

4.3 Creating a Permit To Work

Permit to Work Statements may be created in several ways:
1. Onthe ISOLATION STATEMENT list
a. Select an isolation Statement

b. Right-click > New Permit

File b WorkGroup | fig Administration  Audit Trail  Reports | Event Overview | () Help

() ISOLATION STATEMENTS |[Z] PERMIT TO WORK

Actions 4 Import ‘8 Bport | ] Preview (L Print  LockBox Coversheet - W
ShortID JobDescription CreatedBy  GeneratedDate  Status  Specialifo  LockBoxNumbe Det
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2. Or PERMIT TO WORK > Actions > New Permit

File /4 Work Group | ffy Administration  Audit Trail  Reports  Evert Overview () Help

1
ISOLATION STATEMENTS E_EE PERHWTOWORKi

DELETE ALL Permits

Pormit Number. EreakdownA17-P TW-000001 Lock Bex Number 1
o0 o — B i —
reana e Pt N ——

4. Add or Remove the Isolation Statement associate with this Permit:
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Pemit Mumber: | Bresklonn 17 TW-000001 Lock Box Number: 1
Pemt. Exouy Trme: [e7nmn | [stdfimn | (200w |
Pemit Holder:
P Holde Cortact Detais:
SELECTED ISOLATION STATEMENT ] Afcted by Exchive Cortrol CLICK TO ADD OR REMGVE

5. Click OK to proceed to the next step
6. New Permit is now listed on the Event Details Page > PERMIT TO WORK:

File £ Work Group | (fy Administiation  Audit Tral  Reports  Event Overview ) Help

(5 ISOLATION STATEMENTS FERMIT TO WORK

Actions | (] Preview  Export apﬁm Send to Outlook - T

PTWShort|D PTWExclusiveCortrol  PTWABEC ~ PermitHolder PemitHolderDets Permit Start Time PermitEndtime: Permit Status PemitCreatedE
18 PM |1 18 PM | DRAFT cnguyen

7. Double click the permit to preview
8. Permit can be altered by selecting PERMIT TO WORK > Actions > Edit Permit

File ‘kaﬁmup | (jg Administration  Audit Trail  Reports  Event Overview () Help

£} ISOLATION STATEMENTS PERMIT TO WORK

Actions || 0 Preview  Export ahim Send to Outlook - T
E Mew Permit PTWShortID PTWExclusiveControl PTWABEC  PemitHolder PermitHolderDets Pemit Start Time PemitEndtime Pemit Status PermitCreated

[F  oelete Selected Permit

DELETE ALL Permits.

End of Procedure
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4.4 Send Permit to Outlook

When isolation statement and Work Permits are generated, Permit Coordinator can choose to
issue a copy of the permit to Central Control Room Operator to notify the upcoming isolations.
This will ensure the plant shutdown is in a controlled and timely manner. CCR can then set up
to quickly bring the plant back online once requested work is complete:

1. From Event Details Page, select a permit on the list then

PERMIT TO WORK > SEND TO OUTLOOK

= Event Details
File §Wulk6mup @Adminiﬂmﬁun Audit Trail  Reperts  Event Overview () Help

ISOLATION STATEMENTS L PERMIT TO WORK

Actions @Pmiew Export @Prin{ |5mdmomloak| - T

PTWDesc PTWShort|D PTWExclusiveCortrol  PTWABEC ~ PemnitHolder PermitHolderDets Permit Start Time: PermitEndtime Permit Status PermitCreated |

M | DRAFT cnguyen

2. A new Task will be generated on your Outlook, along with the isolation details:

“ TASK | INSERT ~FORMATTEXT  REVIEW

XS HEEL VED O B P Ql#

High Importance
Save & Delete Forward OneNote | Task Details Mark  Assign Send Status Recurrence  Categorize F\'.\Ilolw1 sl Zoom | Start

Close Complete Task  Report - uUp -~ ¥ Low Importance Inking
Actions Show Manage Task Recurrence Tags Zoom | Ink
Subject BREAKDOWN WORKS - CV802
Start date Sun 16/04/2017 ez ‘ Status ‘NM Started -
Due date Tue 16/05/2017 9| priority  High -] wcomplee 0% ]
[ | Reminder  Tue 16/05/2017 L 418PM + | 4 | Owner Cong Nguyen
PERMIT NUMBER:

BreakdownAl7-PTW-000007

JOB DESCRIPTION:
BREAKDOWN WORKS - CV802

WORK AREA:
FMG-SM-STOCKYARD
EQUIPMENT ID:

cveoz

PERMIT START TIME:
16/04/2017 4:18:28 PM

PERMIT END TIME:
16/05/2017 4:18:28 PM

PERMIT STATUS:
DRAFT

PERMIT HOLDER:
Bob

PERMIT HOLDER CONTACT DETAILS:
Tetra Radio Channel 219

=

myPermit.doc
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3. On the ribbon, Select Assign Task

AT NSO R S
| TASK | INSERT  FORMAT TEXT  REVIEW

v, O II |> Private Q 75

: | High Importance
Save & Delete Forward OneNote | Task Details | Mark | Assign Senfl Status Recurrence | Categorize Follow 9 Zoom | Start
Close Completp Task port - Up~ ¥ Low Importance Inking
Actions Show pManage Task Recurrence Tags Zoom Ink
Subject BREAKDOWMN WORKS - CVB02
Start date Sun 16/04/2017 | Sats | Not Started -
Due date Tue 16/05/2017 :|| priority [ High ~| % Complete 0% %
[ |Reminder  Tue 16/05/2017 | 41apM . il Owner  Cong Nguyen
PERMIT NUMBER:

BreakdownAl17-PTW-000007

JOB DESCRIPTION:
BREAKDOWN WORKS - CV802

WORK AREA:
4. Type in the recipient’s email address and click SEND

End of Procedure

4.5 Printing

45.1 Print Isolation Statement

The best way to print an Isolation Statement is to export it to Microsoft Word Document format
then print:

1. Onthe Event Details Page. Select ISOLATION STATEMENT tab.

2. Click on EXPORT > Export to Word > Export Selected Statement

= Event Details - olEN
Fie b viork Grow | g Adminitistion  Audit Trsl  Reports  Event Overview  Documentateon () Felp

& @ 0 FERMIT TD WORK | (21 WORK PACKS

[ WORK ORDERS,

3. Choose the destination folder then click on Save to proceed

16| Page



Save “

Done, Do you want to open the folder?

Yes Mo Cancel

4. Click Yes to view the file.

End of Procedure

4.5.2 Print Multiple Statements

To print multiple isolation statements
1. Select ISOLATION STATEMENT tab
2. Click on Export > Export to Word > Export All Statements

) Even

File ﬁWolk Group 3 Administration  Audit Trail Reports  Event Overview  Documentation -@ Help
ISOLATION STATEMENTS | (@ SPECIFIC ISOLATION REQUIREMENTS | [ PERMIT TO WORK | () WORK PACKS WORK ORDERS

Actions ‘_G Import

@ Preview @ Print  LockBox Coversheet - Yx

@ Eporttobxcel » | CrostedBy  GererstedDate Status  Specialifo  LockBoxMNumber  PlantArealName

SY170PFO1-15-0000)
BporttoPDF— + BT onguyen 26/04/2017 1243 PM | DRAFT 2 FMG-SM-CRUSHINGHUB

SY170PFOTS EporttoWord  » | Export Selected Staternent RAFT 3 FMG-SM-CRUSHINGHUB

Export All Statements

3. Navigate to the folder then click on Save. Note: this progress will take sometime to
generate all statement. The status is displayed on the left bottom corner of the screen:

I:l Exporting 2/ 3 Isolation Statements. Please Wait...

4. Once export is completed. Click Yes to view your files or No to close.
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Export Completed! Do you want To open the folder?

5. To Print Multiple statement. Select File > Bulk Print

File éWolkaup L}Mminishaﬁun Audit Trail  Reports  Event Overview  Documentation @Help

—_—
Printer
| Bulk Print ‘ NTS | @ SPECIFIC ISOLATION REQUIREMENTS PERMIT TO WORK | () WORK PACKS WORK ORDERS
Bulk Prir
Close
TP @Export @ Preview @Pﬁm LockBox Coversheet © Yx

PlartAreaName:
SHINGHUE
FMG-SM-CRUSHINGHUB
FMG-SM-CRUSHINGHUB

6. A new dialog will popup. Click on Select

[[mea ] momme | Py |

FileName Type

7. Select the files you wish to print. Then click on Open to proceed
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N -
SYTTCRRDT-15-00000 IOVINT 12646 .. Misrosaltwiord 8., T2k
7 SYITOPROT-IS- 000002 /T 12246 .. 3R] ;
SYITORRD1-15- 000003 2W/O4T 1246 .. Micrasafrifiara 8. 2| 1. Select your Files

[l :170PF01-15-000001 doc | doc READY
SY170PFO1-5-000002.doc | doc

SY170PFD1-5-000003 doc | doc

9. Select a printer then Print
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General

Select Printer

éFax

Status:
Location:
Comment:

Page Range

A
() Selection

() Pages:

4 @ Brother Color Leq Typel Class Driver | é Microsoft XPS Docurr
[4Secure-Perth-ps on P’

@Secule— Perth-UFR on

(21 Brother QL-570

< I

() Currertt Page

>

Crevoge

Find Printer...

MNumber of copies:
[ Coliate @

|Sd=<x ||R=nmm||FRJNT|

Bulk Print

Completed

Z okl

Frinting 5Y170PF01-1S-000001 doc
Printing 5Y170PF01-15-000002 doc
Frinting SY170PF01-1S-000003 doc

453 Print Permit To Work

End of Procedure

1. From the Event Details page. Click on PERMIT TO WORK tab > Export > Selected

PTW
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File ‘ Work Group Administration ~ Audit Trail Reports  Event Overview  Documentation @ Help

3 1SOLATION STATEMENTS] | 2 PERMIT TO WORK
Actions | (] Preview| | Bgport B Print  Send to Outlook - T

PTWDesc Exportto Excel  » PTWExclusiveControl] PTWABEC ~ PemmitHoldsr PemitHolderDets
i Export ToPDF  » B ||

Scaes o1

Export ALL PTW

2. Repeat the previous steps to export and print documents.

End of Procedure
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5. SHUTDOWN EVENT

5.1 Create Shutdown Event

1. From the Main Login Page. Click Event > New Event. Enter the
Event description and Select Shutdown

E

File 8Account ﬁ Event » Settings  About  Online Discussion Board

FMG Permit To Work

name of the event,

FCg

Create New Event

Breakdown#

Evert Name: | SY170PFO1
Online Mode :

“ong

TrainingData Event Description: ‘Sh'-‘down|

dministrator
}

Event Type: Shutdown
(] Breakdown
(] Templates

9.0 . 8.1 .7,

Cancel

2. From the Main Page select this event from the drop down list

a FMG Permit To Work

=

File 8 Account ﬁ Event » Settings  About  Online Discussion Board

FORTESCUE PERMIT TO WORK SYSTEM

Breakdown

v

Breakdown
BreakdownA17
Onli

TrainingDatabase Access Level: 4

3. Click View Event to continue

File 8 Account ﬁ Event o Settings  About  Online Discussion Board

FORTESCUE PERMIT TO WORK SYSTEM

SY170PFO1

- oM

FMG Permit To Work

UserName: Cong
Role Level: administrator
Accesslevel: 4

Online Mode
TrainingDatabase
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End of Procedure

5.2 WORK ORDERS

5.2.1 Create New Work Order

1. From the Event Details Page. Click on the WORK ORDERS tab > New Work Order

Event Details
File ink Group L&Administlation Audit Trail  Reports  Event DVM

(4 ISOLATION STATEMENTS | @ TSIRs | L] PERMIT TO WORK | ([) WORK PACKS WORK ORDERS

New Work Order J Import Work Orders  Export Work Orders  Delete Work Orders  Delete ALL Work Orders

- WorkOrderMumber WorkOrderDescription Equipment|D PlartArea WorkGroup Start Time: FinishTime: Duration WO Status

Print Barcodes

2. Enter the Work Order Details. Click OK to proceed

Plart Area: |5TGCKYARD

Asset ID: |R[:9m

Woark Order Number |2m33454

Werk Order Description |Servioe Variable Speed Drive CV301-VSDOT

Work Group: |AEE

Start Time: |17/04/2017 08:22
Finish Time:  |[E/04/2017 08:22

3. Work Orders is now appear on the Work Order list:

Event Details
File /b WorkGroup | (i Administiation  Audit Trail  Reports  Event Overview ) Help

(X ISOLATION STATEMENTS | @ TSIRs PERMIT TO WORK | () WORK PACKS WORKORDERS

MNew Work Order  Import Work Orders  Export Work Orders  Delete Work Orders  Delete ALL Work Orders Print Barcodes

WorkOrderDescription EquipmentID PlantArea WorkGroup StartTime: FinishTime Duration
S :d Dri ACH01 STOCKYARD |ABB 7 24

WorkOrderhumber WOStatus

OPEN

End of Procedure
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5.2.2

Import Work Orders from Excel Spreadsheet

Work Orders can be imported into the database in several ways:

1.

3.

Select WORK ORDERS > Export Work Orders > Download Template

File ﬁWulkGroup L_&Administlatiun Audit Trail  Reports  Event Overview  Documentation @Hel

{54 I1SOLATION STATEMENTS | @ SPECIFIC ISOLATION REGUIREMENTS PERMIT TO WORK | (3) WORK PACKS WORKORDERS 1

Mew Work Order  Import Wark OldEl’ Export Work Orders I Delete Work Orders  Delete ALL Work Qrders Print Barcodes

WorkOrderhlumber WorkOrderDes Export To Excel b ftAres WorkGroup Start Time: Finish Time: Duration WOStatus

Download Template

A new Excel file will pop up.

Event Details B T
File b WorkGroup | glg Adminstrtion  AuditTrail  Reports  Everd Ovenvien  Dosumentation () Help
|a B [E—

Expor Wiork Orders: Dol ALL Wtk sy Print Barcentes

1 WoORKPACKS | 7] WoRK ORDERS

Be 0 il ) ENG

Fill in the data as per the template.

WME S & myWorkOrdorTemplate Resd Only] - Excel
-1mummmmmmuwmmmm
s i AN T=E® Bwapte | Geen A K g [hemat Good Newrsl  [Cakculation |
rute imum— BIU- Merge BiCenter = | § - % 9 | %4 & 'Conﬂh-vd'c;::n Explanctory . RPUIIIIIT] Lnked Call  Note
Ogent o o pr— o e o sy
7 cd % fi | 19/05/20171:00 AM
4 A | 8 | c 1 o 1 £ T (= L_H_|
'jwmmrmw WorkOrderDescription EquipmentiD. PlantArea WorkGroup StartDate FinishDate Duration
2| 100492243 BF273-CH290 Install Side Impact Plates 8F273-CH290 Belt Feeder Discharge Chute  SCALPING SCREENING AREA PILBARAACCESSTL  15/05/2017 11:00 AM 15/05/2017 1:00 PM 2
3 100516905 BN151-install RailInserts BN151 Rom 8in PRIMARY CRUSHING AREA TASROPEACCESSTL  15/05/2017 11:00 AM 15/05/2017 12:00 PM 1
4 100538576 RMU14 12Monthly ISLCable way Inspection 33KV 630A Incomer Isolator from RMU15/16  GENERAL FIRETAIL AREA NPLHVT1 19/05/2017 8:00 A 19/05/2017 10:00 AM 2
5 J 100549943 CRC363 Install Drain Pipe Protection CRC363 Tertiary Crusher MP1250 SECONDARY & TERTIARY CRUSHING AREA  PILBARAACCESST3  19/05/2017 8:00PM  20/05/2017 2:00 AM 6
6 100552681 BF363-Shuttle Drive Upgrade BF363 Belt Feeder SECONDARY & TERTIARY CRUSHING AREA  TAST2 15/05/2017 11:00 AM 15/05/2017 12:00 PM 1
100552740 BF364-Shuttle Drive Upgrade BF364 Belt Feeder SECONDARY & TERTIARY CRUSHING AREA  TAS T2 [19/05/2017 1:00 AM_]19/05/2017 8:00 AM 7
8 100558894 BF362:-Shuttle Drive Upgrade BF362 Belt Feeder Drive 2 SECONDARY & TERTIARY CRUSHING AREA  TAS T2 19/05/2017 7:00 A 19/05/2017 7:00 AM 0
s 100568365 S2151-CH154 Discharge Chute-Replace Line  S2151-CH154 Pri Szer Discharge Chute PRIMARY CRUSHING AREA PTWES HP T2 15/05/2017 11:00 AM 15/05/2017 7:00 PM 8
19 " 100576050 CRC363-CH378-Install Crusher Isolation G (CRC363-CH378 Crusher Discharge Chute SECONDARY & TERTIARY CRUSHING AREA  PTWES HP T2 15/05/2017 11:00 AM 15/05/2017 1:00 PM 2
" 100576052 CRC364-CH379-Install Crusher Isolation G CRC364-CH379 Crusher Discharge Chute  SECONDARY & TERTIARY CRUSHING AREA  PTWES HP T3 15/05/2017 11:00 AM 15/05/2017 1:00 PM 2
2 100592945 CRC363 Replace Lube Pump 2 CRC363-LUO1 Crusher Lubrication System  SECONDARY & TERTIARY CRUSHING AREA  TAS T2 19/05/2017 10:30 AM 19/05/2017 11:30 PM 13

Save the Excel spreadsheet to your computer. We will import this spreadsheet in the
next steps:
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@“ ME  INSERT  PAGE LAYOUT FORMULAS DATA REVIEW WVIEW DEVELOPER ADD-INS TEAM
R

Calii RITIEY 2 » ¥ Weap Text Genersl 7 | Normal Bad Good Neutra! Jculat € x (Wil |Z
Copy e d L3
B W BT neA 35 52| EMerge & Conter = | § + % 9 | %3 33| Conditionsl Form ” P Nota osert Deletn Format | &
ormat Panter Fomattng + Table
Cippowd figt P
L2 > K S 19/05/2017 1:.00 AM
A 8 c [ 3 3

1 WorkOrderNumber WorkOrderDescription EquipmentiD PlantArea WorkGroup StartDate Finig
2 100492243 BF273-CH290 Install Side Impact Plates BF273-CH290 Belt Feeder Discharge Chute  SCALPING SCREENING AREA PILBARA ACCESS T1 15/05/2017 11:00 AM 15/¢
3 100516905 BN151-Install Rail Inserts BN151 Rom Bin PRIMARY CRUSHING AREA TAS ROPEACCESSTL  15/05/2017 11:00 AM 15/
4 100538576 RMU14 12Monthly ISLCable way Inspection 33KV 630A Incomer Isolator from RMU15/16  GENERAL FIRETAIL AREA NPIHVTL 19/05/2017 8:00 AM  19/¢
s 100549943 CRC363 Install Drain Pipe Protection CRC363 Tertiary Crusher MP1250 SECONDARY & TERTIARY CRUSHING AREA  PILBARA ACCESS T3 19/05/2017 8:00PM  20/¢
6 100552681 BF363-Shuttle rive Upgrade BF363 Belt Feeder SECONDARY & TERTIARY CRUSHING AREA  TAST2 15/05/2017 11:00 AM 15/¢
7 100552740 BF364-Shuttle Drive Upgrade BF364 Belt Feeder SECONDARY & TERTIARY CRUSHING AREA  TAS T2 [19/05/2017 1:00 aM 19/t
8 100558894 BF362-Shuttle Drive Upgrade BF362 Belt Feeder Drive 2 SECONDARY & TERTIARY CRUSHING AREA  TAS T2 19/05/2017 7:00 AM_ 19/¢

File > Save As > Computer > Browse

myWorkOrderTemplate [Read-Only] - Excel

Save As

@ Sites - Fortescue Metals Group I;I Computer

Current Folder

OneDrive - Fortescue Metals
& G Templates
aroup € » PTW » Version 1.16 » Version 1.15 » FMGPermitToWork » FMGPermitToWork » bin » Debug » Templat.
&, OreDrive Recent Folders
Templates
|D G C:'» PTW » Version 1.16 » Version 1.15 » FMGPermitToWork » FMGPermitToWork » bin » Debug » Te.
- FTOPF Shut
> \\fmgJocal » perth » usv-fr » cguyen » Desktop » FTOPF Shut
Acrount + Add a Place FolderforMau
\Wfmglocal » perth = usv-fr » cnguyen » Desktop » FolderforMau
Options
New folder
\\fmgJocal » perth » usv-fr » cnguyen » Desktop » New fokder
Desktop
\\fmglocal » perth » usv-fr » cnguyen » Desktop
Documents
Browse
3
.
File name: | [Nl OTT
Save as type: Excel Workbook
A e w11 I e o
Authors:  Cong Nguyen Tags: Add atag

| Save Thumbnail

In this example, | will save this Excel Spreadsheet as “myWorkOrder” on my Desktop
5. Back to the FMGPermitToWork.

Select WORK ORDERS > IMPORT WORK ORDERS > Import From Excel File
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File £ WorkGroup | ifs Administration  Audit Trail ~ Reports Event Overview  Documentation  (§J) Help

{4 ISOLATION STATEMENTS | @ SPECIFIC ISOLATION REQUIREMENTS | L] PERMIT TO WORK | () WORK PACKS | (] WORKORDERS

New Work Orderfl| Import Work Orders | Iqum Work Orders  Delete Work Drders  Delete ALL Work Orders Print Barcodes

Import Frem Excel File

Import From Gantt

6. A new window will pop up. Click on Open

Select the Excel Spreadsheet that you saved in the previous step:

B Desktop
MNew folder

"~
: Q% Homegroup h Cong Mguyen @ This PC
tien - Insurance F . -
1 Database - Shor 3 h fa
we - Shorteut E E FolderforMau * }-_ FTOPF Shut | Historian Analyser
et @ EE 4= -
teut . Employee SAP numbers . myWorkOrder (. Permit Matrix April Rev. 3
< Microsoft Excel 97-2003 Worksheet Microsoft Excel Worksheet Microsoft Excel Worksheet
- ) X X
“Q's from Leighte 43.0KB 4.5 KB 334 KB
Shortcut
B

w| | Excel Files W
Open Cancel
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7. Now your pop up window will display the preview data:

% Import Work Orders
Open

WorkOrderMumber WorkOrderDescript  Equipment!|D FlantArea WorkGroup StartDate FinishDate Duration Fg »~
WBFZ’}CHZMM.. BF273.CH290 Be... | SCALPING SCR... | PILBARA ACCES... | 15/05/2017 11:0... | 15/05/2017 1:00... | 2

100516905 BN151-nstall Rai... [EN151 Rom Bin | PRIMARY CRU... | TAS ROPE ACC... |15/05/2017 11:0... | 15/05/2017 12:0... |1

100538576 RMU14 12Month... | 33KV 6304 Inco... | GEMERAL FIRE... [NPIHV T1 15/05/2017 8:00... |19/05/2017 10:0... |2

100549943 CRC363 Install D... | CRC363 Tertiary ... | SECONDARY & .. | PILBARA ACCES... |19/05/2017 8:00... | 20/05/2017 2:00... |6

100552681 BF363-Shuttle Dri... |BF363 Belt Feeder | SECONDARY & ... | TAS T2 15/05/2017 11:0... |15/05/2017 12:0... |1

100552740 BF364-Shuttle Dri... | BF364 Belt Feeder | SECONDARY & .. |TAS T2 15/05/2017 1:00... |15/05/2017 8:00... |7

100558594 BF362-Shuttle Dri... |BF362 Belt Feed... | SECONDARY & .. | TAS T2 19/05/2017 7-00... [19/05/2017 7:00... | 0

100568365 SZ151-CH154 Di... | 5Z151-CH154 Pri... | FRIMARY CRU... |FTWESHP T2 |15/05/2017 11:0... |15/05/2017 7:00... | 8

100576050 CRC363-CH378-... |CRC3B3-CH378 .. | SECONDARY & ... |[PTWES HP T2 15/05/2017 11:0... |15/05/2017 1:00... |2

100575052 CRC3IB4-CHI73... |CRC3IBACHITY .. | SECONDARY & .. [FTWESHP T3 [15/05/2017 11:0... |15/05/2017 1:00... | 2

100552945 CRC363 Replace... |CRC363-LUOT Cr... | SECONDARY & ... | TAS T2 15/05/2017 10:3... | 19/05/2017 11:3... |13

100593305 BF272-CHZTAR... |BF272-CHZ74 Be...| SCALPING SCR... |PTWESHF T1 15/05/2017 11:0... |15/05/°2017 11:0... |0

100600604 BF364-Install Shu... | BF364 Feeder B... | SECONDARY & ... | TAS T2 15/05/2017 11:0... |15/05/2017 3:00... |4

100608020 AF151 - Preset R... |AF151-HYD1 Fee... | PRIMARY CRU... |CUST FP HYDR... |21/05/2017 2:.00... | 21/05/2017 6:00... |4

100612714 CV361-MGO1 Re... |CV3E1-MGDT Co... | SECONDARY & ... | TAS T2 15/05/2017 6:30... | 19/05/2017 10:3... | 16

100613165 BN361-Replace ... |BN361Feed Bin ... | SECONDARY & .. |[PTWESHP T3 |15/05/2017 11:0... | 15/05/2017 12:0... |1

100613551 CRC363 - Replac... |CRC363-LU0T Cr... | SECONDARY & ... | TAS T2 15/05/2017 1:00... | 15/05/2017 2:00... |13

100613826 Replace Diverter ... [CRC361-LUDT Cr... | SECONDARY & ... |CUST FF HYDR... |19/05/2017 1:00... | 18/05/2017 4:00... |3

100613917 CRC361/LUDT - .. |CRC361-LUDT Cr... | SECONDARY & ... | FILBARA ACCES... |21/05/2017 3:30... | 22/05/201712:3... |9

100618070 57151-Replace |... |5Z151 Primary Si... | PRIMARY CRU... |CUST FP LUBE T2 | 20/05/2017 11:3... | 21/05/2017 2:00... |2 oo
£ >

IMPORT | | CANCEL
8. Click IMPORT
o Import Work Orders - 0O
Open

WorkOrderNumber WorkOrderDescript  Equipment!D Plantfrea WorkGroup StartDate FinishDate Duration F9 =
WBFZGCHZ}DM.. BF273-CH250 Be... | SCALPING SCR... | PILBARA ACCES... | 15/05/2017 11:0... | 15/05/2017 1:00... |2

100516305 BN151-Install Rai... |BN151 Rom Bin | PRIMARY CRU... | TAS ROPEACC... |15/05/2017 11:0... |15/05/2017 12:0... |1

100538576 RMU14 12Morth... | 33KV 5304 Inco... | GENERAL FIRE... |NPIHV T1 19/05/2017 8:00... | 19/05/2017 10:0... |2

100549943 CRC363 Install D... | CRC353 Tertiary ... | SECONDARY & ... | PILBARA ACCES... | 19/05/2017 8:00... | 20/05/2017 2:00... |6

100552681 BF363-Shuttle Dr... | BF363 Belt Feeder | SECONDARY & .. | TAS T2 15/05/2017 11:0... | 15/05/2017 12:0... |1

100552740 BF364-Shuttle Dri.. | BF354 Belt Fesder | SECONDARY & .. | TAS T2 19/05/2017 1:00... | 19/05/2017 8:00... | 7

100558834 BF362-Shuttle Dri... | BF352 Belt Feed... | SECONDARY & .. | TAS T2 19/05/2017 7:00... | 19/05/2017 7-00... |0

100568365 SZ151-CH154 Di... | SZ151-CH154 Pri... | PRIMARY CRU... |PTWESHPT2 | 15/05/2017 11:0... | 15/05/2017 7:00... |8

100575050 CRC36ICHITH... |CRCIEICHITE .. | SECONDARY & .. |PTWESHP T2 | 15/05/2017 11:0... | 15/05/2017 1:00... |2

100575052 CRC364-CHI79... |CRCIG4CHITY .. | SECONDARY & .. |PTWESHP T3 | 15/05/2017 11:0... | 15/05/2017 1:00... |2

100592945 CRC363 Replace... | CRC363-LUDT Cr... | SECONDARY & ... | TAS T2 19/05/2017 10:3... | 19/05/2017 11:3... |13

100593305 BF272-CHZ74R... |BF272-CH274 Be... | SCALFING SCR... [PTWESHPT1 | 15/05/2017 11:0... |15/05/2017 11:0... |0

100600604 BF364-nstall Shu... | BF364 Feeder B... | SECONDARY & .. | TAS T2 15/05/2017 11:0... | 15/05/2017 3:00... |4

100608020 AF151- Preset R... | AF151-HY01 Fee... | PRIMARY CRU... |CUST FP HYDR... | 21/05/2017 2:00... | 21/05/2017 6:00... |4

100612714 CV351-MG01 Re... |CVI61-MG01 Co... | SECONDARY & ... | TAS T2 19/05/2017 6:30... | 19/05/201710:3... |16

100613165 BN351-Replace .. | BN361 Feed Bin .. | SECONDARY & .. PTWESHP T3 | 15/05/2017 11:0... [15/05/2017 12:0... |1

100613551 CRC363 - Replac... | CRC363-LUDT Cr... | SECONDARY & ... | TAS T2 19/05/2017 1:00... | 19/05/2017 2:00... |13

100613826 Replace Diverter ... | CRC361-LUOT Cr... | SECONDARY & ... |CUST FP HYDR... |19/05/2017 1:00... |13/05/2017 4:00... | 3

100613917 CRC361/LUDT - ... |CRC361-LUDT Cr... | SECONDARY & ... | FILBARA ACCES... | 21/05/2017 3:30... | 22/05/21712:3.. |9

100618070 57151-Replace ... | SZ151 Primary Si... | PRIMARY CRU... |CUST FP LUBE T2 | 20/05/2017 11:3... | 21/05/2017 2:00... |2 v
< >

——

27| Page



9. The software will import the data into the database:

523

2% Import Work Orders -0
Open
WorkOrderNumber WorkOrderDescript  Equipment|D FlartArea WorkGroup StartDate FinishDate Duration F§ ~
4 100492243 BF273CHZ50 In... |BF273-CH2590 Be... | SCALPING SCR... |PILBARA ACCES... | 15/05/2017 11:0... | 15/05/2017 1:00... |2
100516305 BN151nstall Rai... |BN151 Rom Bin PRIMARY CRU... | TAS ROPE ACC... |15/05/2017 11:0... [15/05/2017 12:0... |1
100538576 RMU14 12Month... | 33KV 630A Inco... | GENERALFIRE... |NPIHV T1 19/05/2017 8:00... | 19/05/2017 10:0... |2
100545943 CRC363 Install D... |CRC363 Teriary ... | SECONDARY & .. | PILBARAACCES... | 19/05/2017 8:00... | 20/05/2017 2:00... |6
100552681 BF363-Shuttle Dri... | BF363 Belt Feeder | SECONDARY & .. | TAS T2 15/05/2017 11:0... | 15/05/2017 12:0... |1
100552740 BF364-Shuttle Dri... | BF364 Belt Feeder | SECONDARY & .. | TAS T2 19/05/2017 1:00... | 19/05/2017 8:00... |7
100558834 BF362-Shuttle Dri... |BF362 Belt Feed... | SECONDARY & ... | TAS T2 19/05/2017 7:00... | 19/05/2017 7:00... |0
100568365 SZ151CH154 Di... |SZ151CH154 Pri... | PRIMARY CRU... |PTWES HP T2 15/05/2017 11:0... | 15/05/2017 7.00... |8
100576050 CRC363-CH378-. 52017 1:00... |2
100576052 CRC364-CH373. 5207 1:00... |2
100552345 CRC363 Replace. Imported 304 new orders, updated 0 existing orders, Rejected 0 Orders 5/201711:3.. 13
100593305 BF272CHZTAR.. 52017 11:0.. |0
100600604 BF364-Install Shu. 5/2017 3:.00... 4
100608020 AF151 - Preset R.. OK 5/2017 6:00... |4
100612714 CV3I61-MGO1 Re.. 52017 10:3.. |16
100613165 BMN361-Replace ... |BN361 Feed Bin ... | SECONDARY & ... |PTWES HP T3 15/05/2017 11:0... | 15/05/2017 12:0... |1
100613551 CRC363 - Replac... |CRC363-LUN Cr... | SECONDARY & .. | TAS T2 15/05/2017 1:00... |19/05/2017 2:00... [13
100613826 Replace Diverter ... (CRC361-LUDT Cr... | SECONDARY & ... |CUST FP HYDR... |19/05/2017 1:00... | 19/05/2017 4:.00... |3
100613917 CRC361/LU01 - ... |CRC361-LUD1 Cr... | SECONDARY & ... | PILBARA ACCES... | 21/05/2017 3:30... | 22/05/201712:3... |9
100618070 5Z151-Replace |... |SZ151 Primary Si... | PRIMARY CRU... |CUST FP LUBE T2 | 204052017 11:3... | 21/05/2017 2:00... |2 e
£ >
IMPORT | | CANCEL
[
Event details View:
=) Event Details
File b Work Group | (i Administration  Audit Trail  Reports  Event Overview  Documentation ) Help
[ ISOLATION STATEMENTS | @ SPECIFIC ISOLATION REQUIREMENTS | L PERMIT TO WORK | () WORK qu [5] WORK ORDERS
NewWork Order  Import Work Orders ~ Export Work Orders  Delete Work Orders  Delete ALL Work Orders Print Barcodes
WorkOrderhiumber  WorkOrderDescrption Equipment|D Plart/rea WorkGroup StartTime FrishTime Duration WOStatus
» BF273.CH290 Install Side Impact Plates BF273.CH290 Belt Feeder Discharge Chute  SCALPING SCREENING AREA PILBARA ACCESS T1 15/05/2017 11:00 AM  15/05/2017 1:00 PM |2
100516905 BN151-nstall Rl Inserts BN151 Rom Bin PRIMARY CRUSHING AREA TAS ROPEACCESST1 | 15/05/2017 11:00 AM | 15/05/2017 1200 PM [ 1 OPEN
100538576 RMU14 12Morihly 1SLCable way Inspection | 33KV 6304 Incomer lsolstor from RMU15/16 | GENERAL FIRETAIL AREA NPILHV T 19/05/2017 800 AM | 19/05/2017 10:00 AM |2 OPEN
100543943 CRC363 Install Drain Pipe Protection CRC363 Tetiary Crusher MP1250 ‘SECONDARY & TERTIARY CRUSHING AREA | PILBARAACCESS T3 |19/05/2017 800 PM | 20/05/2017 200 AM |6 OPEN
100552681 BF363-Shutte Drive Upgrade BF363 Bek Feeder SECONDARY & TERTIARY CRUSHING AREA | TAS T2 15/05/2017 11:00 AM | 15/05/2017 12:00 PM | 1 OPEN
100552740 BF364-Shutte Diive Upgrade BF354 Beh Feder SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 100 AM [ 19/05/20178.00AM |7 OPEN
100558894 BF362:Shutte Diive Upgrade BF352 Beh Feeder Drive 2 SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 700 AM [ 19/05/20177.00AM [0 OPEN
100568365 52151-CH154 Discharge Chute-Replace Line | SZ151-CH154 Pi Sizer Discharge Chute PRIMARY CRUSHING AREA PTWES HP T2 15/05/2017 11:00 AM | 15/05/2017 7.00 PM |8 OPEN
100576050 CRC363.CH378-nstall Crusher sclation G CRC363-CH378 Crusher Discharge Chute | SECONDARY & TERTIARY CRUSHING AREA | PTWES HP T2 15/05/2017 11:00 AM | 15/05/2017 1:00 PM |2 OPEN
100576052 CRC364-CH379-nstall Crusher lsolation G CRC364-CH379 Crusher Discharge Chute | SECONDARY & TERTIARY CRUSHING AREA | PTWES HP T3 15/05/2017 11:00 AM | 15/05/2017 1:00 PM |2 OPEN
100592945 CRC353 Replace Lube Pump 2 CRC363-LUD1 Crusher Lubrication System | SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 10:30 AM | 19/05/2017 11:30 PM | 13 OPEN
100593305 BF272.CH274 Repar Damaged Parent Metal | BF272.CH274 Bet Feeder Discharge Chute | SCALPING SCREENING AREA PTWES HP T1 15/05/2017 11:00 AM | 15/05/2017 11:00 AM [0 OPEN
100600604 BF364-install Shutte Inposition Praxy BF364 Feeder Elect instr Control SECONDARY & TERTIARY CRUSHING AREA | TAS T2 15/05/2017 11:00 AM [ 16/05/2017 300 PM |4 OPEN
100608020 AF151 - Preset Relef Valve Block AF151+HY01 Fesder Hydraulic Power Pack. | PRIMARY CRUSHING AREA CUST FP HYDRALILICS T1|21/05/2017 200 AM | 21/05/2017 600 AM |4 OPEN
100612714 CV361-MGD1 Repai Twisted Catenary CV361-MGD1 Conveyor Magnet Assembly | SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 6:30 AM | 19/05/2017 10:30 PM | 16 OPEN
100613165 BN361-Replace Lower Bin Side Walls BN361 Feed Bin Assembly SECONDARY & TERTIARY CRUSHING AREA | PTWES HP T3 15/05/2017 11:00 AM | 15/05/2017 1200 PM | 1 OPEN
100613551 CRC353 - Replace Lube Pump 1 CRC363-LUD1 Crusher Lubrication System | SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 1:00 AM | 19/05/2017 200PM |13 OPEN

End of Procedure

Update Work Orders

As the shut gantt changes, you may need to update the work order details such as start / end
time, adding new work orders, remove work orders from gantt, etc. To update and adding new
work orders:
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1. From your Event Details Form, select WORK ORDERS > Export Work Orders >

Export List to Excel

@ Event Details
File Eka Group @Admmﬁmun Audit Trail  Reports  Event Overview  Documentation () Help
1
(5 ISOLATION STATEMENTS | @ SPECIFIC ISDLATION REGUIREMENTS | L) PERMIT TO WORK | () WORK PACKS | (5] WORKORDERS | I
New Work Order  Import Work Orders I[wpnll Work Orders I Delete Work Orders  Delete ALL Work Orders Print Barcodes
Export To Excel r List to Excel

Download Template

WorkGroup
P

OPEN

BN15-nstal Ral Ingerts BN151 Rom Bin PRIMARY CRUSHING AREA TASROPEACCESST1 | 15/05/2017 1100 AM 1 OPEN
100538575 RMU14 12Monthly ISLCable way Inspection | 33KV 630A Incomer lsolatorfrom RMU15/16 | GENERAL FIRETAIL AREA NPIHV T 19/05/2017 800 AM | 19/05/2017 10:00 AM |2 OPEN
100545543 CRC363 Install Drain Pipe Protection CRC363 Tertiary Crusher MP1250 SECONDARY & TERTIARY CRUSHING AREA PILBARAACCESS T3 | 19/05/2017800PM | 20/05/2017 200 AM |6 OPEN
100552681 BF363-Shutte Diive Uporade BF363 Bett Feeder SECONDARY & TERTIARY CRUSHING AREA | TAS T2 15/05/2017 11:00 AM | 15/05/2017 1200 PM |1 OPEN
100552740 BF364-Shutte Diive Upgrade BF364 Bett Feeder SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 100 AM | 19/05/20178:00 AM. |7 OPEN
100558894 BF362-Shuttle Diive Upgrace BF362 Be Feeder Dive 2 SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 700 AM | 18/05/2017 700 AM. |0 OPEN
100568365 SZ151.CH154 Discharge Chute-Replace Line | SZ151.CH154 Pi Sizer Discharge Chute PRIMARY CRUSHING AREA PTWES HP T2 15/05/2017 11:00 A | 15/05/2017 700 P8 OPEN
100576050 CRC363.CH78-Instal Crushee Isolation G CRC363.CH378 Crusher Discharge Chute | SECONDARY & TERTIARY CRUSHING AREA | PTWES HP T2 15/05/2017 11:00 AM | 15/05/2017 100 PM |2 OPEN
The software will copy all the work orders into a new spreadsheet:
WS & & TARE TOOLS Book! - Bicol : . v
HOME INSERT  PAGELAYOUT ~FORMULAS DATA REVIEW VIEW DEVELOPER ADD-INS TEAM  DiSIGN -« . %
Table Name: | [l Summarize with PivotTable E m™ B  Meader Row | First Column Filter Button | — e
Tablet B Remove Duphicates. o b‘:‘ beread 3 Total Row Last Cokumn m =
 Resize Table &= Convert to Range Shoer - €3 Uniin  Banded Rows | Banded Columns R S
Properties. Tools. External Table Data Table Style Optior Table Stybes.
AL s i x v fe | WorkOrderNumber

WorkOrderNumber B

2. Update your data in this spreadsheet, or adding new work orders
In this example, | will add 2 new work orders to the list:

500005064 CV262/CH270 Install perma

PILBARA ACCESS T2

SCAL M 18 OPEN

504

15/05/2017 1100 AM 18/05/20

i
SLACUNGAREA e I
123123154 New work Order 1 New work Order 1 SCALPING SCREENING AREA Team 1 017 11:00 AM |16/05/2017 5:00 AM 18 OPEN.
507 123454457 New Work Order 2 New Work Order 2 STACKING AREA Team 2 15/05/2017 11:00 AM 16/05/2017 7:00 AM 20 OPEN .

Save and close excel to your desktop once all changes have been made
3. Back to the FMGPermitToWork
Select WORK ORDERS > IMPORT WORK ORDERS > IMPORT FROM EXCEL File

Repeat the previous steps to import the work orders:
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Import Work Orders

= I |
Open
] WorkOrderNumber  WorkOrderDescript  EquipmentID FlantArea WorkGroup Start Time Finish Time Duration WC A
2l BF273-CH250 In... |BF273-CH250 Be... | SCALPING SCR... | PILBARA ACCES... |15/05/2017 11:0... |15/05/2017 1:00... | 2 OFE
i 100516505 BN151-Install Rai... | EN151 Rom Bin PRIMARY CRU... | TAS ROPE ACC... |15/05/2017 11:0... | 15/05/2017 12:0... [1 OFE
i 100538576 RMU14 12Morth... | 33KV 6304 Inco... | GENERAL FIRE... | NPIHV T1 15/05/2017 8:00... | 19/05/2017 10:0... |2 OFE
1 100545543 CRC363 Install D... |CRC363 Tertiary ... | SECONDARY & ... | PILBARA ACCES... | 19/05/2017 8:00... | 20/05/2017 2:00... |6 OFE
100552681 BF363-Shuttle Dri... | BF363 Belt Feeder | SECONDARY & ... | TAS T2 15/05/2017 11:0... | 15/05/2017 12:0... [1 OFE
100552740 BF364-Shuttle Dri... | BF364 Belt Feeder | SECONDARY & ... | TAS T2 15/05/2017 1:00... | 19/05/2017 8:00... |7 OFE
] 100558894 BF362-Shuttle Dri... | BF362 Bekt Feed... | SECONDARY & ... | TAS T2 19/05/2017 7:00... 19/05/2017 7.00... | 0 OPE
] 100568365 SZ151CH154 Di... | 5Z151-CH154 Pri... | PRIMARY CRU... |PTWES HP T2 15/05/2017 11:0... | 15/05/2017 7.00... |8 OFE
; 100576050 CRC363CH378.. B/20171:00... |2 OFE
1 100576052 CRC364-CH37S. B/20171:00... |2 OFE
100532345 CRC363 Replace. Imported 2 new orders, updated 504 existing orders, Rejected 0 Orders 52017 11:3... |13 OFE
100593305 BF272CHZ74R.. 52017 11:0... |0 OFE
100600604 BF364-Install Shu. 5/2017 3.00... |4 OFE
] 100608020 AF151 - Preset R.. 0K 5/2017 6:00... |4 OFE
] 100612714 CV361-MGO1 Re.. B201710:3... |16 OFE
1 100613165 BN361-Replace ... |BN361 Feed Bin ... | SECONDARY & ... | PTWES HP T3 15/05/2017 11:0... | 15/05/2017 12:0... [1 OFE
i 100613551 CRC363 - Replac... |(CRC363-LUDT Cr... | SECONDARY & .. [TAS T2 15/05/2017 1:00... | 19/05/2017 2:00... {13 OFE
1 100613826 Replace Diverter ... |CRC361-LU0N Cr... | SECONDARY & ... |CUST FP HYDR... |19/05/2017 1:00... | 19/05/2017 4:.00... | 3 OFE
100613917 CRC361/LU01 - ... |CRC361-LUDT Cr... | SECONDARY & ... | PILBARA ACCES... | 21/05/2017 3:30... | 22/05/201712:3... |9 OFE
100618070 5Z151-Replace |... |5Z151 Pimary Si... | PRIMARY CRU... |CUST FP LUBE T2 | 20/05/2017 11:3... | 21/05/2017 2:00... |2 OPE
K >
] IMPORT | | CANCEL
¢
End of Procedure
5.2.4 Delete Work Orders
To delete Work orders from the database, highlight the work orders from the list then
1. WORK ORDERS > Delete Work Orders
&= Event Details
File é Work Group | 5 Administration  Audit Trail  Reports  Event Overview  Documentation \9,' Help
£ ISOLATION STATEMENTS | @ SPECIFIC ISOLATION REQUIREMENTS | £ PERMIT TO WORK | (7) WORK PACKS | (-] WORK ORDERS
MNew Work Order  Import Work Orders  Export Work Orders I Delete Work Orders I Delete ALL Work Orders Print Barcodes
WorkCrderNumber WorkCrderDescription EquipmentID PlantArea WorkGroup Start Time Finish™
123123+008 New work Order 1 New work Order 1 SCALPING SCREENING AREA 15/05/2017 11:00 AM | 16/1
1.23454e+008 New Work Order 2 New Work Order 2

Confirmation

Areyou

sure you want to delete work order number1,23454e+ 0087

Cancel

2. Click Yes to proceed.
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End of Procedure

5.2.5 Import Work Orders from SAP & Microsoft Project

This method is recommended for major shutdown where shutdown gantt (Microsoft Project) is
available. The program requires 2 pieces of information: SAP Work Orders details (IW49N or
IW38) and Microsoft Project.

1. Log into your SAP and enter IW49N:

Menu Edit Favorites Extras System Help
€ mEn 0 Nag e@@ B
SAP Easy Access

GIE] Sl = &]2]| ][]

'V@ Favorites

}ﬁ_‘?

P [ Notifications

b [ Work Orders
B M Matariale

2. Onthe Order Header tab, clear the Period information:

=4 BEE
Progam Edt Goto System Heb

& 2488 QHE HBoa @@
Display Orders and Operations: Selection of Orders and Operations
5|8l [ Address search || settiement Recewvers || Prod. Resources/ Took || Customer Feids |

Order Status
[loutstandn  [#lin process () Completed [DHstorical  Selection Profie

1]

_ GenersjAdmintrston | Loc/AcctAssignment |, Operaton | Dates Mscelaneous

[ Order Headar
Order
Order Type
Functional Location
Equpment
Assembly
Materal
Seral Number
Addit. device data
Hotfication
Main work center
Plant work center
Period B
Partner a
[Jindl.object st

ggeggegegegagg s

\I<Ml
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3. Click on General / Administration and Key in your Shutdown Revision. For example:
KV170P07:

- oeeE
ét_Goto Heb SAP;—-

Display Orders and Operations: Selection of Orders and Operations
oE | Prod. Resources/Tooks |

D]

[o]o]o]o]a]o]a] [o] [=]s]e]s]e]s]

5888888898|8689858|B€8

N oo |

wISpIay Wi

4. Click on l to run the query

5. Select Settings > Layouts > Current

|FMG-SM-KV-CNVY-CONVEY-CV704 -WHOO1 | CV704-WHO1 Conveyor Take-Up Winch | mo
\mmmvmu -WHO01 IC\ﬂml w Take-Up Winch JDIW
FMG-SM-KV-CNVY-CONVEY-CV704 -WHOO1  CV704-WHO1 Conveyor Take-Up Mlllch oo

6. Select the following columns:
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IENEIEYED]
Displayed Columns
Icnlmlum I
Description
Functional Location
Description of functional location

Operation/Activity
Operation short text

(D]

No. confim. sips

<DL I (][]
Save Layout
Name: PermitLayout
[ User-specific [“I Default setting
t3

8. Click on green tick to continue

9. Your screen will now displays the work order details:

-fL'l.li\” §

L {FNCEHAS-OWY-COVEY IV WHOSL ZICVID ML Coenvarar Take-Us Wexch 100G, RoE On (=]

N SR DRV P07 M0 | CV704-WHO1 Conveyor Take-Up Winch (0010 [Mount Proxy Sensor Brackets. | S|

N |CV704-WHO1 Conveyor Take-Up Wnch 0030 Gean Up Demobe & Lock Off m

| \ PR e GO |

| | Mount IFM Sensors

|| | [Run Cables To Winch Panel |

u FMG-SM-KV-CHVY-CONVEY-CV704 -WHOO1 | CV704-WHO1 Conveyor Take-Up Winch 0070 Mount Companents In Winch Panel

B Test/Check New Wirng

u | |QAIQC V701 Prspawi nteriock Upgrade

| [100509177 V701 Pin+Paw Interiock Upgrade

u |

Ll ‘ i

u \ [ ) ENORES N v I

N FMG-SM-KV-ON [CV701.4H01 Conveyor Take-Up Winch (0100 Test/Check New Wrng

u |FMG-SM-KV-CHVY-CONVEY-CV701 -WHOO1 | CV701-WHO1 Conveyor Take-Up Winch 0105 |QA/QC CV701 Pn+Paw Interiock Upgrade

[FMGSH-KV-CHVY-CONVEY-CV701 WHOOL | CV701WHOL Conveyor Take-Up Winch 0110 |Gean Up Demobe SLock O |

] \mséu&v&twwm—cmf WHOO1 | CV701-WHO1 Conveyor Take-Up Winch 0120 |RAMP UP Commssion Proxies =)
100509178 CV702 Prn4pad Inteock Upgrade| [FHG SHAV-CHVY-CONVEY-CV702 WHOOL |CV702-WHO Conveyor Take-Up Winch 0010 JHA's, Pemits, Lock On ] EIE

— T T P P TP i S T — SRS |

[ I

10. Click on the Spreadsheet symbol to save the list




11. Follow the prompts

[ Excel: Number of Key Colu_

B A

No. of key columns

[= Export list object to XXL

An XXL list object is exported with
6367 lines and 6 columns
Choose a processing mode:

@ Table

Q Pivot table

V%]

[ Export list object to _ [X

i@ Microsoft Excel

10.

Save your excel export to a folder.

@9

[

et Pagelwout  Formulas  Data  Revew  View

Worksheet in Basis (1) - Microsoft Excel

e B =
c@osn

LA

By A x SwE B Bwele G T R kb et 4
2 Copy A B = = & & ;!_J @rue #
Fromurmie| B Z U= (|04 [EE W F® Buopacme-] §-% » |30 Q] Cationnt fomut o | biet Dot Tomat | 5, I8 Pedh
cipbosrd Font . Algnment Humber 5 Sty cem tating
TESTVKEY - (& Je | Order
T % 0] T < T ) B i ¥
1 pescription Functionsl Loc. Description Oper/Act. Opr. shorttext E|
2 /100509172 CV704 Pin Interiock Upgrade: Up D05 jma's, Permics, Lock On
3 "oosonn2 010
4 7100509172 V704 Pin Interiock Upgrade Taeupwinh 030 Ciean Up Demobe & Lock O
s "ooson172 Teke-UpWinch 0040 IMA's, Permits, Lock On
6 "100509172 Upgrao Up To0s0
7 "00s09172 CVIDLWHO? Comveyor Take-Up Winch 0060 Run Cables To Winch Pane!
8 Toosos72 Upgrade CVI04-WHO1 Conveyor om0
8 oosomn TakeUpwinch 0080 Terminate New Wiring
10 "100509172 CV704 Pin Interiock Upgrade TereUpWinch 0090 Test/Check New Wiring
11 "100509172 CV704 Pin interiock Upgrade 100 QAGCCVTOL PinePaw interiock Upgrade
12 7100508172 (V704 in nteriock Upgrade FMAG-SH-KV-CNVY-CONVEY-CY704 -WHOOL CVIOLWHO! Comeyor Take-UpWinch 0110 Ciesn Up Demobe & Lock OFf
13 "100509172 CV704 Pin interiock Upgrade vp o120
16 7100808177 CV701 Pinepom -wnon VI3 W01 Comevor ToteUpWinch 0020 1WA’ Permis, Lock On
15 100509177 WO TokeUpWinch 0030 MountProwy Sensor Brackets
167100809177 V01 PinPom whoor a0 tock o
17 7100508177 CV701 PinePawi WHOO CVIOL-WHOL Comveyor Take-Up Winch 0050 JHA's, Permits, Lock On
18 "ioosos7? Upgr -whoos CVIDLWHO Comveyor Take-Up Winch 0060 Mount IFM Sensors
197100509177 CV701 PinePaw! -WHOO1 Teke-Upwinch 0070 Run Cables To Winch Pane!
20 "100509177 V701 PinePawl e Whoo o080
21 "100509177 CV701 PinePowl -Who01 CVI01-WHO1 Conveyor "o0%0 ing
22 7300509177 V701 PinePaw -whoo1 ToteUpWinch 100 Tesy/Check New Wiring
25 7100508177 V701 PinePaul Whoo TokeUpWinch 0105 QAIQECVIOI PinePawl Interiock Upgrade
26 "100509177 CV701 PinePawl WHOOL CVIOL-WHOI Conveyor Take-UpWinch 0110 Clean Up Demobe & Lock Off
28 Toosommy whon V01 WHO? Comveror ™
26 /300509178 CV702 PinePawl Interiock Upgrace FMG-SM-KV-CNVY-CONVEY-CV702 “WHOOL CVI02WHOL Conveyor Take-Up Winch 0010 HA's, Permits, Lock On
2 "oosomns Toke-UpWinch 0020 >
H AP Sheet1 93 el A1

11. In this example we will call it DDMMYYYY Week 5 Churn
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= = Documents library
G Network - Shorteut Includes: 2 locations

i Openating Strategies - Shortcut

. Operators Quick reference guides - Shortcut
. OPFO0 Improvement Projects - Shortcut
Ji OPF21 Engineering - Shortcut

). Permitting - Shortcut

J Process Control Engineering - Shortcut

12. Now switch to the Permit to Work Database. Select Work Orders > Import Work
Orders > Import from Gantt

Fie o Wok Group | Administration  Reports  Event Overview  Audit Trsil  Documentation

belp  Took

‘ﬁmmmr!|mm-1wm|. :ﬁ\lmlrm @ ‘

New Wark Ordes | Import Work Orders | Export Work Orders  Delete Work Orders _ Delete ALL Werk Orders

iD  Partiea  WokGroup  SaiTme  FahTime  Dumion  WOSas

13. Click on Select Data Source
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[wmom ] e =

Total Work Orders:

14. Step 1: Click Browse and point it at the excel file you just saved:

Step 1: Select SAP Export Spreadsheet ~ C:\Demo Folder\5 Weeks chum XLSX

Step 2: Select Shutdown Ganit lC:\Duno Folder'\KV170P07 Rev16.mpp

16. IMPORTANT: Ensure your excel file is closed

17. Click on IW49N to run the script, this will take a few minutes to process.
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Microsoft Project Interface -a

[ | v =c

Fitered | SAP Export | Gantt Export | Gant TaskGroups |

D WoOrderthumberWodOrderDescrot. EqupmentlD _ Plartives WokGrop StatDate FrisnDate Duration Statusind Update Statua ~
" _lm‘n -CmPni‘ub -F%'SMCN -CWWHUICD -TASI‘AN ELEC .mﬂﬁw .m|77w .1 ."h [

1 100508177 -Cv_ml Pin+Pawl . -FM-SH'KVCN.. -CV—""-WHHI Co. -TE"AN ELEC .m|7ﬁw...ml77w. ..1 .M

2 100509178 CV702 Pin+Pawl .. FMG-SM-KVCN. CV702WHO1 Co... | TASMAN ELEC 30/06/2017 6:00... | 30/06/2017 7:00... 1 New

3 '1%9175 .meaﬂ ‘FM'SMCN ‘WWHMCD lTAS"AN ELEC .WZDHGIIU lmﬂ)w l‘ l"bl

.‘ -lmim -mw&d -M-EM'KVCN -mean ,-T)S"ANELE: -m|7ﬂm ,-m|77m .1 ."hn

s 100509281 |CVa01 PrvePawl .| FMGSMAVCR.. |CVAD1WHOT Co.. | TASMANELEC | 30/06/2017600.. | 3/06/2017700.. |1 [hew

.ﬁ -100565@4 -mwﬂ. -FMG-SM-KVCR.. -m-wﬁm Co. .TIE"AN ELEC .m”ﬁm. ..m|77m. - .1 .N!W

7 100509286 CV401 Pin+Pawl FMG-SM-KV-DS CV401-WHO1 Co... | TASMAN ELEC 30/06/2017 6:00... |30/06/2017 7:00... |1 MNew

s 100522276 V114 Pepor So...|FMG SMAVRML_|CV11 Converer .. CIVMEC MECH | 30/06/2017600.. | 3/06/2017700.. |1 | Doketed

.5 -IWMB -mh‘!m..-Fm-SH'KVCN.. -m‘w . -TE"AN ROPES .7/“7Eﬂﬂ'5:3“ - .7/ﬂ7mﬂ'5:3ﬂ - .D |

0 100549677 Commission pin a... | FMG-SM-KV-RMI... |CV114WHOD1 Co... | TASMAN ELEC 30/06/2017 6:00... | 30/06/2017 7:00... 1 New

" [100568010 |SZ111 O 1o, | FMGSMAVAML |SZ111 SuerDiv.. | FMGCONMON | 1072017900, |1/072017900 |0 [

.11 -lm” -5211”}‘42“ . -FMG-EM-KV-FMI -521" Sizer Ditv. -FMGCDNADN -1mﬂﬂ179m -1/ﬂ7ﬂﬂ'\79m .D

I3 100568012 |SZ1120n 1 st | FMGSMAVRML |SZ112 Suer Dov.. |FMGCONMON | 10772017830 | 1/072017900... |0

.14 -100665013 -521‘2|}V 2inat... -FMG-SH-KV-RMI. -521]2 Sizer Driv... .FMGU)NMON .1/ﬂ7aﬂ175:31| - .1/117@1?5:“] - .D

15 100568018 SZ1210rv 1inst . FMG-SM-KV-RMI_. | 5Z121 Sizer Dnv... | FMG CONMON 1/07/2017 8:30: 1/07/2017 9:00: 0

IIG -IWIQ -521210'12“ -FMG—SM-KVHm ‘SZ‘ZI Sizer Driv. ‘FHGCONMON ‘1/1:7/2017830 .1074’20‘79“} .0

.17 -IMS -5212D'V1 Inst.. -FMG-SHKVHMI. -521253- Driv... -FMGCDNI\I)N .1/“7@‘”8:3“ - .1/ﬂ7ﬂﬂ175:w - .D

13 100568094 SZ1220rv 2Inst... | FMG-SM-KV-RMI... | SZ122 Sizer Dav...  FMG CONMON 1/07/2017 8:30: 1/07/2017 9:00: 0 .

Total Work Orders:

18. Click on IMPORT to import the preview to the database. Please note the system will
reject any work orders that doesn’t have a Work Group assigned to them.

Confirmation “

Imported 634 new orders, updated 0 existing orders, Rejected 15
Orders, View Report?

<
Q
-3
o

19. Click on View Report to view the list

[T oM NSERT  PAGELAYOUT FORMULAS DATA REVIEW VIOW DEVELOPER ADDANS TEAM congNguyen - |
== X cut = == = . 5 5 &= Gx g | Zhwosm - A
B Calbi - ==E #»- |SwopTe General - » €m m z
P'WEE“W' N . . cmE I F 4 Ef = DH r:.:r arF SZYB(F d &
aste B I - - & - = . . 9 +0 .00 Conditional Format as Insert lete Format . ort ine
- Format Painter u-ig - = EdMergea Center - § - % o Formatting = Table~ Styles-| - . T & Clear Filter - Select =
Clipboard n Font 5 Aignment 5 Mumbar = Styles Cells Editing
014 -l X v ok
: c . . . o \ | s . .
1 [ - e S - [ R - (7 S - [T S - ET N - [T - [ - ] - [
2 otz " v Corvma esany Fapaiad
b DR D e T et IS By pECR T B Bt e
f O Mzt it T DR zrasein
. DR TS T T IS Sk DR s (e e
5 S A e ke et P hare e e B Farin oy
7 oot oo reTAL Lwais e
) UM e ks ot P TSR NS Cunbe v et
h A8 B e Tk T U SV TR CRUSE BN OIS Crnr P B e
v VO B3 Trcrers To [l ———— B SargCnabe Ferdn et
" PO B i T T U SV TR RSB 0 T o et et
v O 5L T To [l ——— OIS Tt ot FendBin ot
L] MO BAE Lirer Trickness test MG Sh KOG CRUSH SN ERO3E Ten Crusher Feed Bin Feciee
el e R RS EIST B B T Emdarfectin s
® L6 Cartsen rga KVIXETH UG v OO ST OEMDS (R Eraer—y pwoe
5 e oes [ e it
v [T — I e crveey oo v VD s e v oS mmemwA e rmmen [T R—r
' DT VTPt it Lo T aETE A e rmme [T a——el
5 OIS V2P ot it gy [ svovaar.crveey o cwcan iy Taa i frevners umremwA e rmmen [Tom—rvr
a T Taa i T awnTE A e rmme [T —ve
5 060 V78t it Uy LB v . CoreE .o o1 VA Cirvers Ta i mowweiEr T T T [T—rvre]
u st nts TELEC awsTAROR o e Tl
2 e e U TN o3 o0 M o o L e O o mme [T —el
u rosen ani TISWELEE DTG 0y Home T
= USSPy St i UG AR SV ALY VMo vt oo e me [
a o women jie— o s
B s on Taesmvirh TasmeLE: e mmen [T R—
a prowi Fimsro Ao s e o 20 ' i
a e pconon o o ' P
a il Aeecmmon o an 2o “ hawd
5 oram oz Sresemmie oo wEran o 0 f it
= iy necmio ‘muren orarsco . s
H T ———" necoi omaren o 50 A v

END OF PROCEDURE
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5.3

WORK PACKS

53.1

Create New Work Pack

2.

3.

From the Event Details Form, Select WORK PACKS > Actions > New Work Pack

File iWolkaup L&Administralinn Audit Trail ~ Reports  Event Overview Documentation Help

(4 ISOLATION STATEMENTS | @ SPECIFIC ISOLATION REQUIREMENTS PERMIT TO WoRK | () WORK PACKS § WORKORDERS
1 H

2
Actions |Eort  Print  View Gantt - %
New Work Pack PackDescrption  WPStaiTme  WPFrmishTme  WPExcluveCortrol WPAfeciedByEC WPSiatus  FlartfreaName

Edit Work Pack
Delete Work Pack
DELETE ALL

New Work Pack form will pop up:

Wk P Mo (WPOOO | g
Wodke Pack Descrgessn: | ] G Preverw | Work Packa |
] Eachme Coraml.
0] Hcte By Exchrm Cotrd
WG [ Wahrmstine Soevar | | A Viah G
[ Remeve |
ik e it
Pt s | -
otk G -
T v
Seach W0 Hmber [Sesch W0 Deserppen.
WokiOmiethrter WokOriwOmcction EemertD Frtirs
.
[T 134 ELOFF Marton VSOCVIZSDAIVT  EN125 Comer e PRINARY CRLISHIG AR
wn 260 Servce VS0 CYIZEYS00T CVIZS Corveror Deve 1 FRINART CRUSHING AR
(aaTase 260 Servce VED CVIZENSD02 V126 Convere Brve 2 PRINARY CRLSHIG AR
s 130 ELOFF Martan VSOCVISTORIVI VIS Corveroreve FRINART CRUSHING AR
| A0ETT20 1 ELOFF Mantan Y50 CVISHDRIVI CVI53 Conweyor Drve PRINAAY CRUSHING AR
(a0 {34 ELOFF Mo VSDCVAS DAIVI £V Comveyr e
a7y 130 ELOFS Martan VSO CV2E0RIVI_ CVE2Corveror Dive
e {34 ELOFF Marean VSDCVOETDAIVI  EN Conveyr e
) 130 ELOFS Martan VSOCVIHAVI_ CVIR2Corveror Deve

(a0 520 Serves VS0 CVIEZNS001 CVIE2 Convey Dave.
a7nant 1200 ELOFF Martan VSOCVETERIVI  CVAST Corveyor v 1
(a2 1304 B OFF Marean VS0 CVIR20AIT | EV762 Canveyor e
| amoaz2 | 130 ELOFS Marian VSOCVIEYLAIVI V7B Canmeyr Bave 1
g | 1301 EL OFF Marson VSOCVIEILAIV? | V76 Comvey Bve
marass | 130 Measm Ao ok Thickness BF271  EF271 e Fesder Mty | scALFINE scREENNG
|amazs | 130 Moo Arssa Bt Thiskmess BF272 | EF272 et Fosces Maertiy T
(oamasy | 130 Measum Assa ok Thickness £6273  E¥273 e Fescer Mty | sCALFING scREENNG
) | 130 Moo Arsa Bt Thiskness 6F214 | EF274 Bt Foscs Maertiy | stupm scresnG
(marres | 130 Measm A ok Thickness B6361  E¥361 B Foscer sty | SECCNOARY A TERTAR
|oamrae | 150 Moo e Arsa it Thiskness 66562 | EF 30 6t Foss Maertiy | secontaRya TERTAR
(ma7azs | 130 Measm Ao ok Thickness £F361  E¥363 B Foscer Mty | SECCNOARY A TERTR
|earrar | 130 Moo e Arssa it Thiskness 66964 | EF754 Bt Foass Mty | secontmRya TERTAR
(marrar2 I Tricknes Cvizs |

|oarmary I Triesnes Cvi2e |
|marars I Tricknes Cv1s1 |
[aearary | 130 Mean e s et Trckmess C1183 |

[ o [ el |

Select the Plant Area from the drop list:

Mew Work Order  Refresh Work Order List
WORK PACK DETAILS

Plant Area: | FMG-SM-CRUSHINGHUB v Preview Gantt
Work Pack Name: |WPO0D01 Shut Ovenvi

Work Pack Description: | | Garttt Preview | Work Packs
[ Exclusive Cortrol
[ Affected By Exclusive Control

Work Group: WorkGroupName  Supervisor Add Work Group

Woark Order Fiters
Plant Area: | "|
Work Group: | v|
Asset ID: | v|
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4.

In the Work Order Filters, select the Plant Area filter. This will narrow down Work

Group and Asset ID filters:

Mew Work Order  Refresh Work Order List

WORK PACK DETAILS

Plant Area: | FMG-SM-CRUSHINGHUB

Work Pack Name: |WP00DOT

C o

| Shutdown Overview

Work Pack Description: | | Gartt Preview | Work Packs
[ Exclusive Cortrol
[ Affected By Exclusive Control
Work Group: WorkGroupMame  Supervisor Add Work Group
Work Order Filters
Plart Avea: | PRIMARY CRUSHING AREA v| | 1
Waork Group: | w
Asset ID: |80FT EWP ~
ABB/HES T1
ALST1
CONVATECH ROLLER T3
Search WO Numbl coyyaTECH SCRAP T1 | ]
CONVATECH SCRAF T2
WorkOrg CUST FP BRAKE T1 D Plartfrea
» CUST FP HYDRAULICS T1 101 Conveyor Take-Up Winch | PRIMARY CRUSHING ARE/
CUSTFP LUBE T1 .
2008773|CIUST FP LUBE T2 veyor Drive PRIMARY CRUSHING AREA
FMG CON MON T1 )
2008773 [ e O RERS veyor Drive 1 PRIMARY CRUSHING AREA
2008773{HES T1 veyor Drive 2 PRIMARY CRUSHING AREA
LF OPF T24
2008772|LF OPF T25 veyor Drive PRIMARY CRUSHING AREA
LINMAC T2 )
2008772 oNADELPHOUS veyor Drive PRIMARY CRUSHING AREA
2008773 PILBARA ACCESS PREP veyor Assembly PRIMARY CRUSHING AREA
FILBARA ACCESS T6
2008773|PILBARA ACCESS T7 veyor Assembly PRIMARY CRUSHING AREA
PTWES HF T2
2008773 FTWES HP T3 veyor Assembly PRIMARY CRUSHING AREA
2008773 %? EE“#'_‘FP veyor Assembly PRIMARY CRUSHING AREA
2008773| TAS ROPE ACCESS T1 veyor Assembly PRIMARY CRUSHING AREA
TAS T4
2008773 T4z T5 veyor Assembly PRIMARY CRUSHING AREA
1006643 $ﬁ 1T§ veyor Assembly PRIMARY CRUSHING AREA
2008773|TAS T8 * hveyor Assembly PRIMARY CRUSHING AREA
200877374 | 13W Mech Replace all Tagged Idlers CV153 |cv153 Conveyor Assembly PRIMARY CRUSHING AREA

5. Select Work Group to filter down the work orders. In this example, | will select HES

T1:

Work Order Filters

Plart Area: | PRIMARY CRUSHING AREA

Work Group:  |[FT==R#l

Asset ID: |

[Search WO Number

||search wo D

WorkOrderNumber
100672196

WorkOrderDescription

Check HV Mator Teminal Connection:

EquipmentID FlantArea

WorkGroup Start Time

Drive 1| PRIMARY CRUSHING AREA HES T1

6. Select the Work Orders then click on ADD to select
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Work Order Fitters

‘ PRIMARY CRUSHING AREA

Plant Area:
Work Group: | FT5iR]
Asset ID: \

| Search WO Number

| |Search WO Description

WorkOrderNumber

1 5
100672192

WorkOrderDescription Equipment|D WorkGroup Start Time:

h N i D SHI

\ 2 R
Check HV Motor Terminal Connections | 52152 Sizer Drive 2 | PRIMARY CRUSHING AREA | HES T1 22/05/2017 7:

[ =

Werk Crcler Fllers
Pk rne, | PRIMARY CRUSHING ARER .
Work Group:  HES T1 v
Hasat 0 v
[Seach WG Hrber [Semeh WO Descrton ]
WosOrdertimoer WocOrderliescrption EqupmentiD. Flartives hionGm g anTime FrishTime Duration Add > WankCroerimber Vipamerlescnge EqupmentiD Flartives. Stae Tme Finah Tive. Durtion

52 RIMARYCRU_ | HES T1

212 S| PRIRYCRY HESTI ZwsarT mwamsm @

Lo || IS

7. Onthe Work Pack Details, click Add Work Group

New Work Order  Refresh
WORK PACK DETAILS

Work Order List

Plant Area: | FMG-SMCRUSHINGHUB

Work Pack Name: | WPODOD1

Work Pack Description: |SZ1

52 Sizer Drive 1-

[[] Exclusive Contral
[] Affected By Exclusive Contral

Work Group:

Worl Order Fitters

WorkGroupMame  Supervisor

Plart Area: | PRIMARY C

RUSHING AREA

Work Group: |HES T1

Rsset D |

8. Select the Work Group from the list. Click OK to proceed

Mew Work Group  Edit

WoarkGroupName

WorkGroupSupervisor

25T Franna

ABB

ALS

Convatech Bett

Crane

Custom Fluid Power

FMG lube

FMG Operator

High Energy

Linkforce BM

LinkForce FT
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9. Once work group(s) is selected, the work pack description will be auto generated.
Change the description where suits.

Mew Work Order  Refresh Work Order List

WORK PACK DETAILS
Plart Area: | FMG-SM-CRUSHINGHUB vl

Work Pack Name: |\WP00001

| Work Pack Description: | 52152 Sizer Drive 1-HES |
|| Exclusive Corntrol
[ Affected By Exclusive Control

Weork Group: WorkGroupName  Supervisor Add Work Group
b

Work Order Fiters
Plart fvem: | PRIMARY CRUSHING AREA v|
Work Group: | HES T1 v|
Asset ID: | v|

10. Click OK to proceed

e Uk s Bl Wk O it

Fartfme PG SUERUS-GHUE v | e
o

e Pak s e
[ o e ik
[

[ e by oo ot

Wi et
=
e

s
Pt g, | PRRATY CHUSHING AFER.
WG [EE T

End of Procedure

5.3.2 Create New SIR

Once the Work Pack is created, you can create a new Specific Isolation Requirements for this
newly created Work Pack:

1. From the Event Details, select the Work Pack then Right-click then New SIR
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File ﬁWolkGroup L}Administlation Audit Trail  Reports  Event Overview  Documentation QHelp

@ ISOLATION STATEMENTS | @ SPECIFIC ISOLATION REQUIREMENTS PERMIT TO WORK (2 WORK PACKS WORKORDERS

Actions  Export  Print  View Gantt - %

WorkPackName WorkPack Description WP Start Time WPFinish Time WPExclusiveControl - WPAffectedByEC WP Status PlantAreaName
711 OPEN M USHINGHUB

2. New SIR Form will pop up
= . NewSpecickolinReguewess . -oEa

TR D [
I SYTTeen S mmes Wokpack. PO S2152 Som e 1HES v
© | FMGSMCALS HNGHU L]
o= ok e
Dovccton” WO 216 S D 1 HES

ok ok mmmr—-m-mmﬂﬁum: PRIMARY CRUSHIG AREA FESTI 2205817700 M ZASON S0 (2 (0PEn |

kst Concin / femation

FLTERS
Crosse Fler: SHOM ALL FOINTS FAOM ISOLATION STATEMENTS

P
]
[ painin |
e
[er==n]
[0 ][ camd |

3. Select the Isolation Points for this SIR. You can choose to filter the points from Isolation
Statements OR show all Points:

TSIR Detais
ID: | SYT7OPFO1-SIR-000044
Plant Area” | FMIG-SM-CRUSHINGHUB v
Deserption:* WP00D01-5Z152 Sizer Dive 1HES ]
Status:* | DRAFT v| B ( a rive 1| PRI
LockBax:  LockBoxID 100672152 Check HV Motor Terminal Connections | $Z152 Sizer Drve 2 | PRIN
Isolation Condition / Information
FILTERS
Ium Filter: SHOW ALL POINTS FROM ISOLATIOM STATEMENTS < |
| Search by Equipment ID | |Search by Description |

4. In this example, | will choose to filter all the points:
42| Page



FILTERS

Choose Fitter:
|Sean:h by Equipment 1D | ‘Search by Description
EgquipmentName IsolationPoirt Isolation Level EnergySource fal
TAIL E1
CONVEYOR SUMP PUMF 1 400V SUBS01-MCCO1-5PB01-CVa02 v Electrical
CONVEYOR SUMP PUMP 2 400V SUBB01-MCCO1-5PB02-CVa02 LV Electrical
C/W WINCH MAIN ISOLATOR 400V SUBS01-MCCOT-LVI02-WHO1 Lv Electrical, Mechanical
CV151 WINCH CHAINS 1 CV151 WINCH CHAINS 1 M MECHANICAL
TAIL BRAKE 400V SUB201-MCCO1-CVB01-BKLO v Electrical, Mechanical, Gra
DRIVE 1¥SD LV AUXILIARY SUPPLY 400V SUBB01-MCCO1-CYB01-DRIVET LV Electrical
DRIVE 2 VSD LV AUXILIARY SUPPLY 400V SUBB01-MCCO1LVB01-DRIVEZ Lv Electrical
C/W WINCH MAIN ISOLATOR 400V SUB201-MCCO1-CVB01-WHO1 v Electrical, Gravitational, Me
DRIVE 1¥SD LV AUXILIARY SUPPLY 400V SUBB01-MCCO1-LYB0Z-DRIVET LV Electrical
C/W WINCH MAIN ISOLATOR 400V SUBB01-MCCO1-LVB02-WHO1 LV Electrical, Gravitational, Me
FIRE WATER PUMP SYSTEM 400V SUBB01-MCCOT-FPP-501 Lv Electrical, Mechanical
TURNOWVER PIT WATER BOOSTER FUMP 400V SUB201-MCCO1-PUBDT-SKa01 v Electrical, High Pressure, S
TURNOVER PIT WATER BOOSTER PUMP 400V SUBB01-MCCO1-PUBDZ-5K802 LV Electrical, High Pressure, S
PROCESS WATER PUMP 1 400V SUBB0-MCCOT-PUSHT Lv Electrical, Mechanical
PROCESS WATER PUMP 2 400V SUB20-MCCO1-PUSDZ v Electrical, Mechanical

5. Type in the Asset ID to narrow the list further down:

FILTERS
Choose Filter: SHOW ALL AVAILABLE POINTS

| [sz152

| [5earch by Desciption

EquipmeritName

IsolationPaint

IsolationLevel

EnergySource

ClearlylLabeled

19 o
Add >

StatusRequirg

52152 SIZER TRAVEL MOTOR 1 SR151-MCCO1-5Z152-EM003 v Electrical, Mechanical | Y OFF ]W‘
57152 SIZER TRAVEL MOTOR 2 SR151-MCCO1-52152-EM004 v Blectrical, Mechanical | Y oFF
52152 GEAREOX COOLER FAN 1 SR151-MCCO1-SZ152EM00S v Electiical, Mechanical | Y OFF <Remore
52152 GEARBOX COOLER FAN 2 SR151MCCO1-5Z152EM006 v Blectrical, Mechanical | Y OFF
52152 0IL CIRCULATION PUMP 1 SR151-MCCO1-52152-EM007 v Bectrical, Hydmulic  |Y oFF s Hemave i
52152 0IL CIRCULATION PUMP 2 SR151-MCCO1-SZ152EM008 v Electical, Hydraulic  |Y OFF
52152 LUBE SYSTEM SR151-MCCO1-5Z152EM009 v Blectical, Hydmulic  |Y OFF
57152 DRIVE 1 & 2 ANTICONDENSATION HEATER | SR152-SWB01-A05-5Z152-FB31 v Bectical, Themal  |Y oFF
52152 66KV CB EARTH SWITCH SR152-SWB015Z152A05-E/5W HY Electical Y CLOSED
57152 66KV CB RACKING CONTROL MCB SR152-SWB01-5Z152-A05-FB70 v Blectrical, Mechanical | Y aFF
57152 66KV CB DRIVE FWD SR152-5WB01-5Z152-A05-FWD HY Blectrical, Mecharical | Y RACKED 0UT|
52152 66KV CB EARTH SWITCH SR152 SWB015Z152A06 E/5W HY Electical Y CLOSED
57152 66KV CB RACKING CONTROL MCB SR152-SWB01-5Z152-AD6-FB70 v Blectrical, Mechanical | Y oFF
57152 66KV DRIVE REV SR152-SWB01-5Z152:A06-REV HY Blectrical, Mecharical | Y RACKED 0UT|
52152 66KV CB DRIVE REV (BUS SHUTTER) SR152-SWB01-5Z152A06-REV (SHUTTER) HY Electical N CLOSED
57152 66KV CB RACKING CONTROL ISOLATOR | SR152-SWB02-52152-A05-FE7SOLATOR v Bectrical Y oFF
57152 66KV CE RACKING CONTROL ISOLATOR | SR152-5WEB02-52152-A06-FET0SOLATOR W Blectrical Y OFF
52152 66KV CB DRIVE FWD (BUS SHUTTER) | SZ1525R152 SWBD1-52152A05-FWD (SHUTTER) | HV Electiical N CLOSED
6. Highlight the points which you want to select then click ADD
FILTERS
Choose Fiter: SHOW ALL AVAILABLE POINTS -
[sz152 | [Search by Description
| EquipmentName IsolationPoirt lsolationLevel  EnergySource Clearlylabeled  StatusRequrg
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57152 DECK WATER VALVE MECHANICAL FIELD-5Z152VA1025 Mechanical, Stored | Y
SR151 Blectrical, Mecharical 1
SRI51-M Blectrical, Mechanical ¥
SR151 Hectrical, Mecharical Y Foore
SR157-M Blectrical, Mechanical
SR151-M Hecirical, Hydraulic << Remove Al
Hlectrical, Hydraulic Y
Bectrical, Hydraulic Y
57152 DRIVE 14 2 ANTICONDENSATION HEATER | SR152-SWB01-AD5-5Z152-FB31 W Blectrical, Themal ¥ OFF
52152 6 6KV CB EARTH SWITCH SR162-5WEQ1-SZ152A05-E/SW HV Blectrical Y CLOSED
52152 66KV CB RACKING CONTROL MCB SR152-SWBQ1-SZ152-A05-FB70 v Bectrical, Mechanical | Y OFF
57152 6 6KV CB DRIVE FWD SR152-5WB01-SZ152-A05-FWD HY Blectrical, Mechanical | ¥ RACKED OUT
52152 6 6KV CB EARTH SWITCH SR152-5WEQ1-SZ152-A06 E/SW HV Blectrical Y CLOSED
52152 66KV CB RACKING CONTROL MCB SR152-5WBQ1-SZ152-A06-FB70 v Bectrical, Mechanical | Y OFF
571526 6KV DRIVE REV SR152-5WB01-SZ152-A06-REV HY Blectrical, Mechanical | Y RACKED OUT
52152 66KV CB DRIVE REV (BUS SHUTTER) SR152-5WEQ1-5Z152-A06-REV (SHUTTER) HV Blectrical N CLOSED
52152 6 6KV CB RACKING CONTROL ISOLATOR | SR152-SWB02-52152-A05-FB70-SOLATOR v Blectrical ¥ OFF
571526 6KV CB RACKING CONTROL ISOLATOR | SR152-SWE02:5Z152-A06-FET0-SOLATOR v Blectrical Y OFF
52152 66KV CB DRIVE FWD (BUS SHUTTER) 5Z1525R152-SWEQ1-SZ152-A05-FWD (SHUTTER) | HV Blectrical N CLOSED




Once you are happy with the selected SIR points for the work orders displayed at the top
in the work order list. Select OK

TSIR Datme Wk Packa
1D | SYIPOPROY-SIR00004 WokPack: (WPOL0I1 52152 Sze e THES

P
Deacrption” WPO0H 57152 Saur Dave 146 |
Status” DRAAFT v

LockBar.
laslaton Condton / Hlamater:

G s o ronts
13 | [Sohoy Descroman
s = = =r== g = R I
3 | 0 ermarag Tr =
e 7 s e |y £ T s AP
521 T I3 Beomcd I 'cmm) 57152 0iL CRCULATION FUMP 1
T o s i - it
T i E B a7 o] et
e et et “ R s | st ] aseen ens e
BT & S - o s
SZ152 66KV DRIVE REV | SAT2 IWB01 S22 ADE REV I VE-!H.M-M'I' racken ouf
I ERl I ‘a-au n ‘cm

ST1526 51 CB RACKING COMTROL ISOLATOR | SRISSWRUZSZIRAISFITMSOUATOR |1V et v oeF
52152 5KV CB RACKING CONTROL SOLATOR | SRIS2 SWBOZ SZIRABGFITHS0LATOR | LV ] v oFF

52152 66KV CB DRIVE PWD BUS SHUTTER) | SZISOSR1SZSWIBOT-SZISEAISFWD (SHUTTER) WY

End of Procedure

Create New Permit To Work

After SIR is created, you may now generate a Permit to Work for this SIR / Work Pack:

1. From the Event Details Form, click on SPECIFIC ISOLATION REQUIREMENTS tab

2. Select the SIR from the list, Right-click then select New Permit

File /4 Work Group _L&Adminislmtion AuditTral  Reports  Event Overview  Documentation ) Help

(1) WORK PACKS

WDRKGRDERS‘

@ ISOLATION STATEMERTS | @ SPECIFIC ISOLATION REQUIREMENTS % PERMIT TO WORK

Actions () Import  Biport | (] Preview @an - T
Descry

CreatedBy ‘Speciallnstruction
_ 0D0D1-52152 ve 1LEG  wen 2

3. New Permit Form will popup:

44| Page



Permit Details
Permit Number: S 170PFO1-PTW-000043
Description of work to be completed: | Size:
Plart Area: | FMG-SM-CRUSHINGHUB v
Permit Status | DRAFT v

[ Exclusive Cortrol Required
[] Affected by Exclusive Control

"Pemnit Holder Contact Details:

Lock Box Number:

Pemit Start Time: |26/04/2017 12:01 B
Pemit Expiry Time: |26/05/2017 12.01 B 7 Navs. +14 Navs. +20 Navs

Permit Holder:

——

"M DRAFT

4. Here you can specify new Permit Start Time / End Time, and Permit Holder details if

available:

Lock Box Number:

Pemit Start Time: |26p"ﬂd.v"21]1? 12:01

EM

Pemit Expiny Time: |26f05/'21]1?12:1]1

"| |+'."r'.‘s|w. | |+14nm| |+':I'Inm|

Pemit Holder:

Pemmit Holder Contact Details:

5. Click OK to complete

=

Pemmit Details

Permit Number:  SY170PFO1-FTW-000043
'WPD0001-52152 Sizer Drive 1-HES
FMG-5M-CRUSHINGHUB

DRAFT

[] Exclusive Control Required

[] Affected by Exclusive Control

Description of work to be completed:
Plant Area
Pemt Status

Lock Box Number:

Permit Start Time:  26/04/2017 12:01 (34
Pemit Expiry Time: 26/05/2017 12:01 B~ +7 Davs. +14 Navs +30 Navs

Fomt Hadr
o oGt Decl

Status
DRAFT

Specialinsiruction
0:11 PM
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534 Merging Work Packs

Quick Merging Work Packs will allow user to merge the work orders from 2 or more
Work Packs together. For example:

Merging WP0001 with WP0002 and WP0003 will:

o Transfer WP0002 & WP0003’s Work Orders into WP0001
e Delete WP0002 & WP0003

e Delete WP0002 & WP0003’s SIR (if any exists)

e Delete WP0002 & WP0003’s PTW (if any exists)

1. Select the Work Packs you wish to Merge by holding down the Ctrl Key:
‘Ftk ‘Vbrksmup \ meinis‘ntion Rapoots EvemOv:maw Audit Trail  Documentation OHdp Tools

' '\
{3 ISOLATION STATEMENTS | (] WORKORDERS | () WORKPACKS | @ SPECIFIC ISOLATION REOUIRBIENTS‘E PERMITTDWORK‘

Actions Export  Print  View Gantt - W Refresh Count
| WorkPackName ~ WorkPackDescription

WPExclusiveControl  WPAffectedByEC WP Status

SM-SY-CNVY-TRS001-SS901-FMG OPERT
-SM-SY-CNVY-CONVEY-CV901 -BK01-FMG OPERTATOR |

2. Right Click and Select “Merge Selected Work Packs”

:ﬁle #Wofkﬁnwp bAdimmstrmon Reports  Event Overview  Audit Trail  Documentation ngp Tools

}g tsoumusmaasms’(_‘] wonxonoens‘ @ WORK PACKS ‘0 mtsoumuna:umacsms‘m PERMIT TO WORK
|

Actions Export  Print  View Gantt - %% Refresh Count

WPExciusiveControl - WPAffectedByEC  WPStatus C

View History

3. Click Yes to Confirm

0 Merge the selected Work Packs into WP00001 ?

¥ ]| M |

File éWorkaup | {g; Administration  Reports  Event Overview  Audit Trail Documentation (&3 Help  Tools

) [ |
ﬂ ISOLATION STATEMENTS | (] WORKORDERS (D) WORK PACKS i @ SPECIFIC ISOLATION REQUIREMENTS | (] PERMIT TO WORK |
l ; L

Actions  Export Print  View Gantt - W Refresh Count

WorkPackName WorkPackDescription WPExclusiveControl  WPAffectedByEC WP Status
FMG-SM-SYCFP

} FMG-SM-SY-CNVY-CONVEY-CV901 -BKO1-FMG OPERTATOR

End of Procedure
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5.3.5 Work Pack Shortcuts

To quickly add or remove work orders from Work Pack:

a. Select a Work Pack. Right click on the Work Order list

gmmmmldmom B WORK PACKS .mmmm’mmmm

Actoms Gpon Pt ViewGant - % Rt Count

T WokPakiiame  WokPadkDmoton WrEschmveCortl WP Aactediyes WPSa
WPOO00! PG SSYCFP Cl (=]

b. Right-click on the Work Order list

Fle [P WorkGrovp | ffy Adminisuation  Repors  Event Ovenview  Avdt Tesd_ Documentation ) Help  Tocs

Qmmmml:_)mm (D WORK PACKS .mmmlﬂwnm

Actions  Eport  Print  View Gantt - T Refresh Coumt
T WokPackdione  WokPackDescepten WPbckaveCortnl WeMecedByEC_WPsha
W00 UG SHSYCIP ] 0 loren Wok Pock Name  WPOO004

Wik Pack Dsscryion  FAG M SYCNVY CONVEY CVa01 £X01 MG OPERTATOR
WodkGougs. PG OPERTATOR
Wiok Pack S OPEN
SetTee (10032017 123000PM
187032017 190600 PM

c. Select Add Work Order or Remove Work Orders

End of Procedure.

5.4 ISOLATION STATEMENTS

5.4.1 Create New lIsolation Statement

1. Select ISOLATION STATEMENTS tab.

2. Click on Actions > New Isolation Statement

File ﬁWalk Group L&Administlalicm Audit Trail  Reports  Event Overview  Documentation @ Help

@ ISOLATION STATEMENTS | @ SPECIFIC ISOLATION REQUIREMENTS PERMIT TO WORK | () WORK PACKS 'WORK ORDERS

[ Actions I (7 Impart Q&pon La Preview @Plilﬂ LockBox Coversheet © Yx
-

ezt S | edBy  GenertedDate  Status  Speciallifo  LockBoxNumber  PlantAreaName

@ Edit Statement
‘g Delete Selected Statement

Delete ALL Statements
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3. Anew isolation Statement Form will pop up.
a. Choose the Plant Area from the list
b. Type in the Description

c. Select a Lock Box for this statement

ID: | SY170PF01-1S-D00001
Plart Area:® | FMG-5M-CRUSHINGHUE nd

Description:* | SHUTDOWN WORKS - $2152|
Lock Box = |1 v

Status:™ | DRAFT w

Isolation Condtion  Information:

FILTERS
Choose Fiter: SHOW ALL AVAILABLE ISOLATION POINTS (NO DUPLICATE) -

Search by Equipment 1D Search by Description

4. Choose the Isolation Points from the list. You can further narrow down the list by type in
the Equipment ID or description. Note: you can also choose to show ONLY THE
MISSING POINTS FROM SIR

ID: | SY170PFO1-15-000001
Flart Area:” | FMG-SM-CRUSHINGHUB e
Description:* | SHUTDOWM WORKS - 57152
Lock Box ™ |1 v
Status:* | DRAFT v

Isolation Condition / Information: |

FILTERS

Choose Fiter SHOW ALL AVAILABLE ISOLATION POINTS (NO DUPLICATE) | - |

| 52152 I Search by Description

Auvailable Points

5. Select the point(s) then click Add to select
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EquipmentName Isolation Point IsolztionLevel EnergySource ClearlyLabeled Status Requi S 0
3 57152 DECK WATER VALVE MECHANICAL FIELD-SZ152-VA1025 M Mechanical, Stored Y OFF fuid,

52152 SIZER TRAVEL MOTOR 1 SR151-MCC01-SZ152-EMO02 LV Blectrical, Mechanical | Y OFF Add ALL >
52152 SIZER TRAVEL MOTOR 2 SR151-MCC01-SZ152-EMO04 LV Blectrical, Mechanical | Y OFF
SZ152 GEARBOX COOLER FAN 1 SR151-MCC01-SZ152-EM005 LV Blectrical, Mechanical | Y OFF < Remove
5Z152 GEARBOX COOLER FAN 2 SR151-MCC01-5Z152-EMO06 LV Hlectrical. Mecharical | Y OFF
5Z152 QIL CIRCULATION PUMP 1 SR151-MCCD1-5Z152-EMO07 LV Hlectrical, Hydraulic | Y OFF << Remove Al
5Z152 QIL CIRCULATION PUMP 2 SR151-MCCD1-5Z152-EM008 LV Blectrical, Hydraulic | Y OFF
57152 LUBE SYSTEM SR151-MCCD1-5Z152-EM00S LV Blectrical, Hydraulic | Y OFF
57152 DRIVE 1 & 2 ANTI-CONDENSATION HEATER | SR152-SWB01-AD5-SZ152-FBS1 LV Blectrical, Thermal Y OFF

©71R7 £ OV D CADTU CUNTEL CO1R2 CWDNT €717 ANK C /2N uu Cliuinnd v rincen



FILTERS
Chooss Fiter: SHOW ALL AVAILABLE ISOLATION POINTS {NO DUPLICATE) ~

|sz152 ‘ ‘Search by Description |
Available Poirts
| EquipmentName IsolationPoint IsolationLevel  EnergySource Clotylobeled _ StausRean] o 0
52152 DECK WATER VALVE MECHANICAL FIELD-SZ152VA1025 M Mechanical, Stored | | pdd> | ]
Y Add ALL >
=
.
: << Remove Al
Y
Y
» TICONDENSATION HEATE ] ¥
52152 6.6KV CB EARTH SWITCH SR152-SWBD1-5Z152-A06-E/5W HY Blectrical ¥ CLOSED
57152 6 6KV CB RACKING CONTROL MCB SR152-5WRD1-57152-A05-FRT0 W Blactrical, Mechanical | Y OFF
57152 6 6KV CB DRIVE FWD SRI52-5WRD1-57152-A05-FWD HY Bectrical, Mschanical ¥ RACKED OU
57152 6 6KV CB EARTH SWITCH SR152-5WRD1-57152-A06-E/SW HY Bectrical ¥ CLOSED
52152 6.6KV CB RACKING CONTROL MCE SR152-5WBD1-52152-A06FB70 v Betrical, Mechanical | Y OFF
52152 6.6KV DRIVE REV SR152-5WBD1-5Z152-A06REV HY Hectrical, Mechanical | Y RACKED OU
52152 6.6KV CE DRIVE REV (BUS SHUTTER) SR152-5WBD1-52152-A06REV (SHUTTER) HY Hlectrical N CLOSED
52152 6.6KV CB RACKING CONTROL ISOLATOR | SR152-5WB02-5Z152-A05-FETIHSOLATOR v Blectrical ¥ OFF
57152 6 6KV CB RACKING CONTROL ISOLATOR | SR152-5WE02-57152-A06-FETIHSOLATOR W Blectrical ¥ OFF
S7TART € £II P MBI DN B 1S S0 TTEDL STARIEDRT WD £74RT ANE WM /TN TTEDY | L fEm—— " [ep=—
6. Click OK to create this statement
= -oEm

B sroerLS om0

Pl Aea* | FNG S CRUSHIVGHUE =

Descrgoan SHUTDOMWN WORKS - 52182

[ <]
‘s [DAAFT ~

ks Conchion / masion:

ALTERS
rcase Fte. SHOW ALLAVAILAELE SOLATION FOINTS (40 DUPLEATE] =
a2 oy D
At Forts
Eammrttins ot il Gwmsars  eehlsded S 'L s
Vs Rk N RR sz 'u [ fore ] s s
521526 6 CB EARTH SWITCH sz Swam S1152 A0 15w | Bactmen v |awsen AL 2112 LB SYSTEN SAiE o S22
e w | Bl Mecharical 'Y o SZTCIL CRCULATION PLMP 2 | srig e szrszenose
| ] Beriresl Nocharical ¥ |recxED OUT Eh STISIGHLCRCULATION PUMF | SR 151 MCC01 S2152 ENOIT
52152660V CB EARTH SWITCH |z smun szvzamesn |2 = I |cwsen — 7152 GEARROXCOOLER FANZ |sm sz szrsz nnns
e w Becrsl Nechurca ¥ o5t 21 GEAREGX COOLER FAN 1 SR18TMCCDT S2152 EMuEe
521526 Y LANVE REV |srisz swhn s2i52 A REY Tw Bearesl Nechorica ¥ [ReckEDOUT 52152 STER TRAVEL NOTORZ SR8 MCD1 S2152 EMOM
r B SHUTERY | &3 Becren 0 lcuosen 52152 STER TRAVEL HOTOR 1 SRS MCCD 52152 EM0R9
smiszesy soLAToR | o Bl i o
saiszeeny =0LATon | ] = ¥ ore
521526 6K CO DRIVE FWD JUS SHUTTER) | S21S25R152:SWBH1 SZ152-A05 D (SHUTTER) Y Becrcal W

End of Procedure

5.4.2 Print Isolation Statement

The best way to print an Isolation Statement is to export it to Microsoft Word Document format
then print:

5. On the Event Details Page. Select ISOLATION STATEMENT tab.

6. Click on EXPORT > Export to Word > Export Selected Statement
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ViorkGroup_| g Adrinistation Al Tral  Repors Evenl Ovendew  Documentaton () Help

R

- %
e B Frtieaions
i il S

7. Choose the destination folder then click on Save to proceed

Done, Do you want to open the folder?

8. Click Yes to view the file.

End of Procedure

5.4.3 Print Multiple Statements

To print multiple isolation statements
10. Select ISOLATION STATEMENT tab

11. Click on Export > Export to Word > Export All Statements

File éka Group L_&Adminishalion Audit Trail  Reports  Event Overview  Documentation 0 Help

@ ISOLATION STATEMENTS | @ SPECIFIC ISOLATION REQUIREMENTS PERMIT TO WORK | [} WORK PACKS WORK ORDERS

Actions ;a Import Export |@ Preview @ Print  LockBox Coversheet < Yx
ShortiD Q EBporttoExcel b | CreaiedBy  GenertedDaie Staus  Specilifo  LockBoxMumber  FlantAreaName
3
SY170PFO14S BporttaPOF + b nguyen 26/04/2017 12:43 PM | DRAFT 2 FMG-SM-CRUSHINGHUB
SY170PFOT-S EqottoWord b | Export Selected Staternent RAFT 3 FMG-SMCRUSHINGHUB

Export All Statements

12. Navigate to the folder then click on Save. Note: this progress will take sometime to
generate all statement. The status is displayed on the left bottom corner of the screen:
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" Exporting 2/ 3 Isolation Statements, Please Wait...

13. Once export is completed. Click Yes to view your files or No to close.

Export Completed! Do you want To open the folder?

14. To Print Multiple statement. Select File > Bulk Print

File ﬁWolkGloup &Adminisllaliun Audit Trail Reports  Event Overview  Documentation @Help

—
Printer
| AT ‘ NTS | @ SPECIFIC ISOLATION REQUIREMENTS PERMIT TO WORK | () WORK PACKS WORK ORDERS
ulk Pri
Close
e @Export @ Preview aplil\t LockBox Coversheet e Yx

JobDescription CreatedBy GeneratedDate
c 2 2:31 PM DRAFT SHINGHUB
FMG-SM-CRUSHINGHUE

SY170PFO1-15-000003 | SHUTDOWN WORKS - CW151 |cnguyen 26/04/2017 12:44 FM | DRAFT FMG-SM-CRUSHINGHUB

15. A new dialog will popup. Click on Select
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16. Select the files you wish to print. Then click on Open to proceed

P=E? - Date ey

L
SYTTCRRDT-15-00000 IOVINT 12646 .. Misrosaltwiord 8., T2k
7 SYITOPROT-IS- 000002 T 12246 . M 3R] ;
SYITORRD1-15- 000003 2W/O4T 1246 .. Micrasafrifiara 8. n2m| 1. Select your Files

17. Your selected files are now added to the list. Click Print to proceed
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18. Select a printer then Print
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Select Printer

Eg @ Brother Color Leg Typel Class Driver i % Microsoft XPS Docurr

(21 Brother QL-570 154 Secure-Perth-ps on P
=i Fax 4 Secure-Perth-UFR on

>

m

Page Range

@A Number of copies:

() Selection () Currert Page

() Pages: [ Callate @




Bulk Print

—onn
|s¢=¢ ||R=nm||PR]NT|

Frinting SY170PF01-1S-000001 doc
Printing 5Y170PF01-1S-000002 doc
Frinting SY170PF01-1S-000003 doc

Completed

End of Procedure

5.4.4 Print Lock Box Cover

Lock Box Coversheets may be printed from the program:

1. From the Event Details Page, Select Isolation Statements tab > Lockbox Coversheet

File 5 ‘Work Group Administration  Audit Trail

Reports  Event Overview  Documentation @Help

@ ISOLATION STATEMENTS

@ SPECIFIC ISOLATION REQUIREMENTS PERMIT TO WORK

() WORK PACKS WORK ORDERS

Actions :—almpart @E}(pan @leiew aplil\ll LockBox Coversheet |

- %

Speciallnfo Lock BoxMNumber

FMG-SM-CRUSHINGHUE

2. New window will popup
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Export | Print

Export Selected to PDF

Export All to PDF

SYTOPFOHSH0MOZ | SHTDOWN PIORKS - SZI51 | FMG-SUCAUSHINGHUE
SY170PFO115 200003 | SHTEOWM VIORKS - C1181 | FMG SMCALISHINGHLE

41 o1 W+ ®

LOCKBOX: 1

@ 8D0ud-| wx

Fod | Net

starEmEn nen. SY170PF01-1S-000001
oesenpnon. SHUTDOWN WORKS -

SZ152

SR151MCCH1-S2162 EM003
2 RIS MOCIN.SZ182EM008

s S

2162 SIZER TRAVEL MOTOR 1
52152 SIZER TRAVEL MOTOR 2

SRSt

LER FAN 1
ERFAN

s SR11MCCI-SZ162 EM007
d SR151MCCI-S7152 EM008
I SRI51MCCI-SZISZEM009

SZ162 OIL CIRCULATIOH PUMP 1
52152 OIL CIRCULATIGH PUMP 2
SZ152 LUEE SYSTEM

5.5

K 41

d1b Ve @@ GE@E-]| 0%

% Fortescue

LOCKBOX: 1

P R

Find | Next

o noN. SY170PF01-1S-000001

STATEMENT NUMBER:

pe SOLATION SHUTDOWN WORKS -
s2152

'SR161-MCC01-5Z162-EM003
SR151-MCC01-52152-EM004
'SR161-MCC01-52162-EM00§
SR151-MCC01-52152-EM006
'SR161-MCC01-5Z162-EM00T
SR151-MCC01-52152-EM008
'SR161-MCC01-5Z162-EM009

S7162 SIZER TRAVEL MOTOR 1
7152 SIZER TRAVEL MOTOR 2
S7162 GEARBOX COOLER FAN 1
52152 GEARBOX COOLER FAN 2
S7162 OIL CIRCULATION PUMP 1
52152 OIL CIRCULATION PUMP 2
S7162 LUBE SYSTEM

ENG

End of Procedure

SPECIFIC ISOLATION REQUIREMENTS

240 PM

551

Create new SIR

To create a new SIR from a WorkPack, please refer to Chapter 5.3.2

1. From The Event Details. Select SPECIFIC ISOLATION REQUIREMENTS tab >
Actions > New SIR

55|Page



‘
)

File ﬁw‘nksmup Administration  Audit Trail  Reports  Event Overview Documentation 4/ Help

i
4 ISOLATION STATEMENTS |@ SPECIFIC ISOLATION REQUIREMENTS | PERMIT TO WORK | (1) WORK PACKS WORKORDERS
L

Actions @\mpoﬂ Bport | (]| Preview @P.im - T

a Mew SIR iption CreatedBy GeneratedDate Status Speciallnstruction PlantAreaMame

@) Edisr
() Delete selected SR
@

Delete ALL SIR

Please note: you will need to create a new Work Pack before creating new SIR.

2. Select the Plant Area from the list

‘

TR Betole ID: | SY170PFO1-SIR-000046 Vu\m::f\ vl
| Plant Area:” |G SM-CRUSHINGHUB v ]
Status:* | DRAFT v
LockBax:

Isclation Condition / Information:

FILTERS

Choose Fiter: SHOW ALL POINTS FROM ISOLATION STATEMENTS -

search by Equipment ID | [search by Descrption

3. Select the available work pack for this SIR. This will populates all the work orders details
belong to the work pack

1D: | SYIR0POI SRO0ME

PP SUCHUSHGHS El
Sescpin ]
Stua |DRAFT Bl

Lockr

Ik Condie | vimton

futens
Chonee P S0 AL TS FRON SOLATH STATEMENTS
oy B © et Dot
—= == T
et LT 2 (vt LT cLaep 2 " AL | wpeue oo || [ aaniss
st eETCLNe 3 comsimeLTcue 3 “ e | [sphieD ochEn
st et ¢ vt cuse 4 A enc | T
st T s cvstaeLrcuane 5 u e | e ochen e
cnsieET e s |Cvis1 BELT CLaMe & 0 TMECHANCAL W |AeeLED LOCKED safmen
et e camniT u e | wocxen
“ e, | e
o w S, Macarica [ lore
waror sz w |Ben, mowren | jore
w St Hactarcal ¥ fore
s w G e 1 ore
SZ151 OIL DRCULATION PUMF | SAISHMCCD1-SZ151-EMOOT w Beancd, Hydmie |V |QFF
Work Packs
WorkPack: [WP0002.CV125 Conveyor Assembly-Convatech Bek v
Work Orders

4. Select the Isolation Points for the SIR
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Work Packs

WorkPack: WP00DD2CV125 Conveyor Assembly-Convatech el v

Work Orders

TSIR Details
ID: | SY170PF01-SIR-000046
Plant Area™ | FMG-SM-CRUSHINGHUB
Description:* WPOD002-CV125 Conveyor Assembly-Convatech Beft
Status:* | DRAFT
LockBaox:
Isolation Condition / Information:
FILTERS

Choose Fiter: SHOW ALL AVAILABLE POINTS

1 I [cvizg || sezrch by Descrption

13W Mech Conv Serap Senvice CV126 | CV126 Canveyor Assembh

13W Mech Conv Scrap Senvice CV153 | CV153 Conveyor Assembh

IsolationPoint

IsolationLevel

EncrgySaurce

5. Click OK to proceed.

End of Procedure

5.6 PERMIT TO WORK

CV125 BELT CLAMPS 2 CWV125 BELT CLAMPS 2 M MECHANICAL N APPLIED LOCKED | Visual Add ALL >
CV125 BELT CLAMPS 3 CV125 BELT CLAMPS 3 M MECHANICAL N APPLIED LOCKED | Visual

CV125 BELT CLAMPS 4 CV125BELT CLAMPS 4 M MECHANICAL N APPLIED LOCKED | Visual < Remove
CV125 BELT CLAMPS § CV125 BELT CLAMPS 5 M MECHANICAL N APPLIED LOCKED | Visual

CV125 BELT CLAMPS & CV125BELT CLAMPS 6 M MECHANICAL N APPLIED LOCKED | Visual
CY125 WINCH CHAINS 1 CV125 WINCH CHAINS 1 M MECHANICAL N APPLIED LOCKED | Visual

CV125 WINCH CHAINS 2 CWV125 WINCH CHAINS 2 M MECHANICAL N APPLIED LOCKED | Visual

CV125 WINCH CHAINS 3 CV125 WINCH CHAINS 3 M MECHANICAL N APPLIED LOCKED | Visual

CV125 WINCH CHAINS 4 CW125 WINCH CHAINS 4 M MECHANICAL N APPLIED LOCKED | Visual

CV125 BULK WATER ADDITION SPRAY FIELD-277777777337277772 M Mechanical, Stored CLOSED Test/Try and

CV125 FIELD WINCH ISOLATOR FIELD-CW125-WHO1-CPB1001 Lv Blectrical, Gravitational | Y OFF Test / Try

CV125 V5D 1600A ACB SR706-CV125-VSD01-ACE Lv Blecrical, Mechanical | Y RACKED OUT Completed H'

CV125 V5D AUX SWITCH SR706-CV125VSDO1-AUX SWITCH | LV Electrical Y QFF Completed H'

CV125 WEBBA CHUTE COMPRESSOR SR706-MCCO1-CV125CHOT-CPOT | LVW/M Hectrical, Mechanical | Y OFF Test / Try

CV¥125 DRIVE MOTOR HEATER SR706-MCCO1-CVI25EMDT-HEDT  |LV Electrical, Themmal Y QFF Test /Ty

CV125 GEARBOX PUMP&FAN COMBINATION | SR706-MCC01-CV125GB01-DROT  |LV Hectrical, Hydraulic | Y OFF Test / Try

5.6.1 Create New Permit to Work

1. From the Event Details. Select PERMIT TO WORK tab > Actions > New Permit

File ‘ﬁWu.ksruup L&Adminisllalmn Audit Trail  Reports __Event Overview Documentation () Help

(4 ISOLATION STATEMENTS | @ SPECIFIC ISOLATION REQUIREMENTY PERMIT TO WORK

(D) WORK PACKS WORK ORDERS

Actions || | Preview  Bport (LjPrint  Sendto Outlook

- %

| New Permit PTWShotID

Delete Selected Permit

([ oetere st pemis

PTWExclusiveControl PTWABEC ~ PermitHolder PemitHolderDets

2. A new Permit to Work Form will pop up
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Permit Start Time: PemitEndtime: PemitStatus PemitCre:

17 12:01 PM  DRAFT




Permit Details
Lock Box Number:

Pemit Number. | SY170PFO1-PTW-000044
EEmyiEdue e i Permit Start Time: [26/04/2017 15:06 v
Pemit Expiry Time: [26/08/2017 15:06 O] [+70ms | [s14Dam | [220Dme

Plant Area:

Pemit Status | DRAFT
["] Exclusive Control Required
(] Affected by Exclusive Control

Descrption

3. Click Add

Permit Details
Lock Box Number:

Permit Number:  SY170PFO1-PTW-000044
P e e Permit Start Time: [26/04/2017 15:06 B
Flant frear
Pamit Expry Time: 28/05/2017 1506 O] [7nms | [sa0me | [annms

Pemit Status | DRAFT
[ ] Exclusive Control Required
[] Affected by Exclusive Control

Description

4. Select a SIR. Then click OK
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Search by Equipment 1D

Search by Description

Shart|D

5. Fillin the Permit Details Section. Click OK to proceed

Pemit Details

Pemit Number
Descrption of work to be completed!
Plant Area
Permit Status

1

SY170PFO1-FTW-D00044

CV125 Work Pack|

FMG-SM-CRUSHINGHUB.

DRAFT

[ Exclusive Cortrol Required
[] Affscted by Exclusive Control

Lock Bax Number:

Pemit Start Time: |26/04/2017 15:06 B
Pemit Expiy Time: [26/05/2017 15.06 [
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End of Procedure




5.7 REPORTS

5.7.1 Isolation Matrix

File ‘ka Group &Admmsllamm Audit Trail | Reports | Event Overview Bocumentation () Help
Isolation Matrix I
Permit Matrix

{4 ISOLATION STATEMENTS | @ SPECIFIC ISOLATION REQUI (€] WURKPPCIG‘ WORK ORDERS ‘

Generate Reports
New Work Order  Import Work Orders  Export Work Ordy ALL Work Orders Print Barcodes

WorkGroup
EENING AREA Team 1 1100 AM 1 OPEN
BFZ73-CH290 Install Side Impact Plates BF273-CH230 Bet Feeder Discharge Chute | SCALPING SCREENING AREA PILBARA ACCESS T1 15/05/2017 11:00 AM | 15/05/2017 1:00 PM
BN151-nstall Rail Inserts BN151 Rom Bin PRIMARY CRUSHING AREA TAS ROPE ACCESS T1 15/05/2017 11:00 AM | 15/05/2017 12:00 PM
RMU14 12Mortthly 1SLCable way Inspection 33KV 630A Incomer Isolator from RMU15/16 | GENERAL FIRETAIL AREA NPIHVT1 18/05/2017 8:00 AM | 19/05/2017 10:00 AM
CRC363 Install Drain Pipe Protection CRC363 Tettary Crusher MP1250 'SECONDARY & TERTIARY CRUSHING AREA | PILBARAACCESS T3 | 19/05/2017 00 PM | 20/05/2017 200 AM
BF363-Shuitle Drve Upgrade BF363 Belt Fesder 'SECONDARY & TERTIARY CRUSHING AREA | TAS T2 16/05/2017 1100 AM | 15/05/2017 12:00 PM
BF364-Shuitle Drve Upgrade BF364 Bel Fosder 'SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 100 AM | 19/05/2017 B00.AM
BF362-Shuitle Drive Upgrade: BF362 Belt Feeder Diive 2 'SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 700 AM | 19/05/2017 700 AM

OPEN
OPEN
OPEN
OPEN
OPEN
OPEN

A S e e

5Z151CH154 Discharge Chute-Replace Line | SZ151-CH154 Pr Sizer Discharge Chute PRIMARY CRUSHING AREA PTWES HP T2 15/05/2017 11:00 AM | 15/05/2017 7:00 PM OPEN
CRC363-CH378nstall Crusher Isolation G CRC363:CH378 Crusher Discharge Chute | SECONDARY & TERTIARY CRUSHING AREA | PTWES HP T2 15/05/2017 11:00 AM | 15/05/2017 1:00 PM OPEN
CRC364-CH378 Install Crusher lsolation G CRC364.CH379 Crusher Discharge Chute | SECONDARY & TERTIARY CRUSHING AREA | PTWES HP T3 15/05/2017 11:00 AM | 15/05/2017 1:00 PM OPEN

CRC363 Replace Lube Fump 2 CRC363 LUDT Crusher Lubrication System | SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 10:30 AM | 19/05/2017 11:30 PM | 1
BF272-CHZ74 Repair Damaged Parent Metal | BF272.CH274 Bek Feeder Discharge Chite | SCALPING SCREENING AREA PTWES HP T1 15/05/2017 11:00 AM | 15/05/2017 11:00 AM
BF364-nstall Shuttle Inpostion Proxy BF364 Feeder Bect Instr Control SECONDARY & TERTIARY CRUSHING AREA | TAS T2 15/05/2017 11:00 AM | 15/05/2017 3.00 PM

AF151 - Preset Releif Valve Block AF151-HY(1 Feeder Hydrulic Power Pack | PRIMARY CRUSHING AREA CUST FP HYDRAULICS T1|21/05/2017 200 AM | 21/05/2017 6:00 AM OPEN
CV361-MGD1 Repair Twisted Catenary CV361-MGO1 Conveyor Magnet Assembly | SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 6:30 AM | 19/05/2017 10:30 PM OPEN
BIN361-Replace Lower Bin Side Wals. BN361 Feed Bin Assembly SECONDARY & TERTIARY CRUSHING AREA | PTWES HP T3 15/05/2017 11:00 AM | 15/05/2017 12:00 PM | 1 OPEN
CRC363 - Replace Lube Pump 1 CRC363-LUDY Crusher Lubrication System | SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 100 AM | 19/05/2017 2:00 PM OPEN

@

OPEN
OPEN
OPEN

5

=

=

Ed

@

Replace Diverter Valve CRC361 CRC361-LUDT Crusher Lubrication System | SECONDARY & TERTIARY CRUSHING AREA | CUST FP HYDRAULICS T1 | 19/05/2017 1.00 AM | 19/05/2017 800 AM |3 OPEN
100813917 CRC361/LUD1 - Replace Wom Drain Pipe CRC361-LUDT Crusher Lubrication System | SECONDARY & TERTIARY CRUSHING AREA | PILBARA ACCESS T3 21/05/2017 330 PM | 22/05/2017 12:30 AM | 9 OPEN
100612070 SZ151Replace labels forfluid couplings. SZ151 Primary Sizer PRIMARY CRUSHING AREA CUST FP LUBE T2 20/0/2017 11:30 PM | 21/05/2017 200AM |2 OPEN
100618071 $Z152Make up labels for fluid couplings SZ152 Secondary Sizer PRIMARY CRUSHING AREA CUST FP LUBE T2 22/05/2017 TOD AW | 22/05/2017 230 AM |2 OPEN
N0612370 RFAR1-Renastion / Adi st Neflector RFARTCHIAR Rek Freder Nischame Chite | SFCONNARY & TERTIARY CRIISHING ARFA| TAS T2 19052017 130 PM_ | 20/06/2M17 420 AM |15 OPFN

52152 SUZR TRAVEL MOTOA |
7152 SZER TRAVEL MOTOR 2 | SZ151 6 66V CB RACKING CONTROL ISOLATOR, CV1S1 BELT CLAMP 2
FAN 1 | 52151 £ 6KV CB DRIVE FND |CVIS1 BELT CLANR 3
| FANZ UTTER) _|CV1S1BELT CLAMP 4
S215201L CIRCULATION PUMP 152151 6,66V CB DRIVE REV (US SHUTTER) _ CV1S1 BELT CLAMP §
Z1520IL. CIRCULATION PUMP 2| SZ151 6 6KV CB EARTH SWITCH CV151 BELT CLAMP §
57152 LUBE SYSTEM SZ151 66KV CB I
SZ151 66KV CB RACKING CONTROL ISOLATOR | CW151 WINCH CHAINS 2
SZ151 6 6K CB RACKING CONTROL MCE

SZ151 6 6KV CB RACKING CONTROL MCB

57151 6 EKV DRIVE REV

521 LER FAN 1

57151 AL CIRCULATION PUMP 1
szisoL

52151 SIZER TRAVEL MOTOR 1
52151 SIZER TRAVEL MOTOR 2

60| Page



5.7.2

Permit Matrix

Event Details
File b WorkGroup | (i Administration  Audt Trail || Reports | EventOvenview  Jocumentation ) Help
ISOLATION STATEMENTS | @ SPECIFIC ISOLATION REQUI Iso‘ation MBVUD‘ (D) WORK PACKS ‘ 'WORK ORDERS ‘
Permit Matrix
Generate Reports .
New Work Order  Import Work Orders  Export Work O ALL Work Orders Print Barcodes
WorkOrderNumber  WorkOrderDescription EquipmertiD WorkGroup “StertTime FiishTime Duration WOStatus
3 EENING AREA
100492243 BF273CH290 bstal Side Impact Pltes BF273CH290 Bell Feeder Discharge Chide | SCALPING SCREENING AREA PILBARAACCESS T1 | 15/05/2017 1100 AM | 15/05/2017 100PM |2 oPEN
100516905 BN151-Install Rail Inserts BN151 Rom Bin PRIMARY CRUSHING AREA TAS ROPE ACCESS T1 15/05/2017 11:00 AM | 15/05/2017 1200 PM | 1 OPEN
100538576 RMUT4 12Moritly SLCsble way nspection | 33KV 630A Incomer soitorfrom RMU1S/16 | GENERAL FIRETAIL AREA NPIRVTT 19/05/2017 £00 AN | 18/0/2017 10:00 A |2 oPEN
100545043 CRCI3 Irstal Dran P Prsscion CRC363 Tertary Crusher MP1250 SECONDARY & TERTIARY CRUSHING AREA |PILBARAACCESS T | 19/05/2017 800 PM | 20/05/2017 200AM |6 oPEN
100552681 BF363 St Dive Upgrade BF363 Bet Feoder SECONDARY & TERTIARY CRUSHING AREA | TAS T2 15/05/2017 11.00 AW | 16/06/2017 1200 P |1 OFEN
100552740 BF364-Srutle Dive Upgrede BF364 Bet Feeder SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 00 AM | 19/05/2017 800 AM |7 oPEN
100558894 BF362-Shuttle Drive Upgrade BF362 Belt Feeder Drive 2 SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 700 AM | 19/05/2017 700 AM |0 OPEN
100562265 SZI51.CHIBE Dicharge Chure-Reploce e | SZI51CHISA Pr Sier Discharge Crite | PRIMARY CRUSHING AREA PTWES 1P T2 15/05/2017 11:00 AM | 15/05/2017 700 PM |8 oPEN
100576050 CRC363CH37E nsal Cusher koo G| CRC363.CH378 Crusher Discharge Chute | SECONDARY & TERTIARY CRUSHING AREA | PTWES HF T2 15/05/2017 11:00 AM | 16/06/2017 100 PM |2 oPEN
100576052 CRC364CH378 Insiall Cusher bolaion G| CRC364CH378 Crushe Discharge Chute | SECONDARY & TERTIARY CRUSHING AREA | PTWES HE T3 15/05/2017 1100 AM | 16/T6/2017 100 PM_|2 OFEN
100592945 CRC363 Replace Lube Pump 2 CRC363-LUDT Crusher Lubrication System | SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 10:30 AM | 19/05/2017 11:30PM |13 oPEN
100593305 BF272-CH274 Repair Damaged Parent Metal BF272-CH274 Belt Feeder Discharge Chute SCALPING SCREENING AREA PTWES HP T1 15/05/2017 11:00 AM | 15/05/2017 11.00 AM | 0 OPEN
100500604 B354 nstal Shutte Inpostion Prosy B354 Fesder Bect Ity Cortrol SECONDARY & TERTIARY CRUSHING AREA | TAS T2 15/05/2017 11:00 AM | 15/0/2017 300PM |4 oPEN
100608020 AF151 -Proset Relef Valve Bock AF151-HYD1 Fesder Hyerauic Power Fack | PRIMARY CRUSHING AREA CUST F HYDRAULICS T1 | 21/05/2017 Z0DAM |21/05/2017600 AM |4 oPEN
100812714 CV361M301 Repar Twisted Catenary CV361-M301 Conveyor Magnet Assembly | SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 630 AN | 18/06/2017 1030 P |16 oFEN
100613165 BN36 Replace Lower Bin Side Wals BN36T Feed Bn Assembly SECONDARY & TERTIARY CRUSHING AREA | PTWES HP T3 15/05/2017 1100 AM | 15/06/2017 1200 P |1 oPEN
100613551 CRC363 - Replace Lube Pump 1 (CRC363-LU01 Crusher Lubrication System SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 1:00AM | 19/05/2017 200 PM |13 OPEN
100513826 Repiace Dveer Valve CRC61 CRC361LU1 Crusher Lubnication System | SECONDARY 4 TERTIARY CRUSHING AREA | CUST FP HYDRAULICS T1 | 18/05/2017 100 AM | 19/05/2017 £00 AM |3 oPEN
100813817 CRCI1/LUD - Replaoe Wom Dran Fips | CRC361LUD1 Crusher Lubricaion Syetem | SECONDARY & TERTIARY CRUSHING AREA | PILBARAACCESS T3 | 21/05/2017 330 PM | 22/05/2017 1230 AM 3 oPEN

HINGHU

FMG- 1
MG SMCRUSHINGHUE | SYT70RFD1 FTW 000044 mm?msmﬂm NA

5.7.3

General Reports

10

PEN] | 200877385

P 3 o
25 OPEN] | 200877362
DRAFT
PEN] | 200886037

1. From the Event Details page. Click Reports > Generate Reports

Event Details
file  fh Work Group | (i Administration  Audit Trai| | Reports | Event Ovenview  ffocument ) Help
ISOLATION STATEMENTS | @ SPECIFICISOLATION REQ fsletion Vet ) WoRK PPDG‘ WORK ORDERS ‘
Permit Matiix
Generate Reports -
New Work Order  Import Work Orders  Exp ALL Work Orders Print Barcodes

WorOrderNumber _ WorkOrderDescrtion EqipmortlD WorkGroup FrishTime
1.23123640 6/05/2017 18

BF273.CH290 st S mpact Pltss BF273CH290 Bek Fesder Discharge Chite | SCALPING SCREENING AREA PILBARAACCESST1 | 15/05/2017 11:00 Al | 15/05/2017 100 PM |2 opEN
10056505 BN15T-istal Rl Insens BN151 Rom Bin PRIMARY CRUSHING AREA TASROPEACCESSTI | 15/U5/2017 1100 AM | 15/05/2017 1200 PM |1 oreN
100538576 RMUI T2Worthly 1SLCsble way Inspaction | 33KV 6304 Incomer slator from RMU15/16 | GENERAL FIRETALL AREA NPIHVT! 19/05/2017800 AM | 19/05/2017 10:00 AM |2 orEN
100545843 CRC383 Intal Dran P Protection CRC383 Tetior Crusher MP1250 SECONDARY & TERTIARY CRUSHING AREA | PILBARAACCESS T | 19/05/20178.00PH | 20/05/2017200AM |6 oreN
100552881 B736%-Shtle Dnve Lpgrace 87363 Bel Fescer 'SECONDARY & TERTIARY CRUSHING AREA | TAS T2 15/05/2017 11:00 AM | 15/05/2017 1200 PM |1 opeN
100552740 BF 364 Shutte Dive Lpgrads BF364 ok Fesder SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 100 AM | 19/05/2017 800 AN |7 opeN
100558854 87362 Sttt Dive Upgrace 87362 Bet Feeder Dive 2 'SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 700 AM | 19/05/2017 700 AW |0 opeN
100568365 SZ151.CH 154 Discharge Chute-Replace Line. | SZ151-CH154 P Ser Discharge Chide | PRIMARY CRUSHING AREA PTWES HP T2 15/05/2017 11.00 AM | 15/05/2017 700 P |8 oPEN
100575050 GRC363.CHI7B-instll Gusher soltion G| GRC363CH378 Gusher Discharge Crute | SECONDARY 8 TERTIARY GRUSHING AREA | PTWES HP T2 15/05/2017 11:00 AM | 15/05/2017 100 PM_|2 opEN
100575052 CRC364.CHI70nstall Cusher scition G| CRC364.CH379 Crusher Discharge Crute | SECONDARY & TERTIARY CRUSHING AREA | PTWES HP T3 15/05/2017 11:00 AM | 15/05/2017 1:00 P |2 opeN
100582945 CRC363 Replace Lube Pump 2 CRC363LU01 Crusher Lubrication System | SECONDARY & TERTIARY CRUSHING AREA | TaS T2 19/05/2017 10:30 AM | 19/05/2017 T1:30PM |13 oreN
100583305 BF272.CHZ74 Repa Damaged Parert Metsl | BF272.CH274 Bek Feeder Discharge Chute | SCALPING SCREENING AREA PTWES HP T1 15/05/2017 11:00 AM | 15/05/2017 11:00 AM |0 opeN
100600604 BF364-nstal St Inpostion Proy BF364 Foeder Bct nsr Cotrol SECONDARY & TERTIARY CRUSHING AREA | TAS T2 15/05/2017 11.00 AM | 15/05/2017 300 P |4 opeN
100608020 AF151 - Preset Relef Vaive Block AF15THYD Feeder Hycraulc Power Pack | PRIVARY CRUSHING AREA CUSTFP HYDRAULICS T1 | 21/05/2017200AH |21/05/2017600AM |4 opeN
00612718 CV361MGD1 Repir Twisted Caterany CV351-MGO1 Conveyor Magnet Assembly | SECONDARY & TERTIARY CRUSHING AREA| TAS T2 19/05/2017630 AM | 19/05/2017 1030 PM |16 oPEN
100613165 BIN361 Feplac Lomier Bn S Wals BN361 Feod Bin Assembly 'SECONDARY & TERTIARY CRUSHING AREA PTWES HP T3 15/05/2017 11:00 AM | 15/05/2017 1200 P |1 opEN
100612851 CRC33 - Replsos Lubs Pump 1 CRC363LU01 Crusher Lubrication System | SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 100 AM | 19/05/2017 200 PH |13 opeN
100612826 Replace Diverer Vaive CRC261 CRC361LU01 Crusher Lubrication System | SECONDARY & TERTIARY CRUSHING AREA | CUST FP HYDRAULICS T1 | 19/05/2017 T00AM | 19/05/2017 400 AM |3 oreN
100613917 CRC361/LUCT -Replace Wom D Fpe | CRC361-LUO1 Crusher Lubrcation Sytem | SECONDARY & TERTIARY CRUSHING AREA PILBARAACCESS T3 | 21/05/2017330PM | 22/05/2017 1230 AM |9 orEN
100618070 SZ151-Replace labeks for lud coupings SZ151 Prmay Sizer PRIVARY CRUSHING AREA CUSTFPLUBET2 20/05/2017 1130 PM [ 21/0/2017 200 AW |2 oreN
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2. Select the type of report you want to view by selecting from the drop down list

z

FILTER

seLecTTvee: | Work Orders

STATUS: [{EN

Print Work Order Barcodes

PRINT PREVIEW
WorkOrderliumber  WorkOr EqupmentiD Plartérea WorkGroup StartTime FinishTime. Duration WO Status
123123008 New work Order 1 New work Onder 1 SCALPING SCREENING AREA Team 1 15/052017 11:00 AM | 16/05/2017 500 AM |18 OPEN
100452243 BF273CH230 Instal Side Impact Piates BF273CH290 Bek Fesder Discharge Chute | SCALPING SCREENING AREA PILBARA ACCESS T1 15/052017 11:00 AM | 15/05/2017 100 PM |2 OPEN
100516905 BN151-nsial Rail Inserts BN151 Rom Bin PRIMARY CRUSHING AREA TASROPEACCESS T1 | 15/05/2017 11:00 AM | 15/05/2017 12:00 FM |1 OPEN
100538576 RMU14 12Monthly 1SLCable way Inspection | 33KV 630A Incomer Isolatorfrom RMU15/16 | GENERAL FIRETAIL AREA NPIHVT! 19/052017 800 AM | 19/05/2017 1000 AM |2 OPEN
100549943 CRC363 Install Drain Pipe Protection CRC363 Tetiary Crusher MP1250 SECONDARY & TERTIARY CRUSHING AREA| PILBARAACCESS T3 |13/05/2017 800 PM | 20/05/2017200 AM |6 OPEN
100552681 BF363-Shutte Diive Upgrade BF363 Bel Feeder SECONDARY & TERTIARY CRUSHING AREA| TAS T2 15/052017 11:00 AM | 15/05/2017 1200 PM |1 OPEN
100552740 BF364-Shuttle Diive Upgrade BF364 Bel Feeder SECONDARY & TERTIARY CRUSHING AREA| TAS T2 19/052017 1:00AM | 19/05/2017 800 AM |7 OPEN
100558834 BF362Shutte Diive Upgrade BF362 Bet Fesder Drive 2 SECONDARY & TERTIARY CRUSHING AREA| TAS T2 19/05/2017 700 AM | 19/05/2017 700 AM |0 OPEN
100568365 SZ151CH154 Discharge Chute-Replace Line | SZ151CH154 Pi Sizer Discharge Chute PRIMARY CRUSHING AREA PTWES HP T2 15/05/2017 11:00 AM | 15/05/2017 700 PM |8 OPEN
100576050 CRC363CH378-nstall Crusher lsolation G CRC363.CH378 Crusher Discharge Chute | SECONDARY & TERTIARY CRUSHING AREA | PTWES HP T2 15/05/2017 11:00 AM | 15/05/2017 100 PM |2 OPEN
100576052 CRC364CH373Hnstall Crusher lsolation G CRC364CH379 Crusher Discharge Chute | SECONDARY & TERTIARY CRUSHING AREA | PTWES HP T3 15/05/2017 11:00 AM | 15/05/2017 100 PM |2 OPEN
100552945 CRC363 Replace Lube Pump 2 CRC363-LUDT Crusher Lubrication System | SECONDARY & TERTIARY CRUSHING AREA | TAS T2 19/05/2017 10:30 AM | 19/05/2017 1130 PM |13 OPEN
100583305 BF272CH274 Repair Damaged Parent Metal | BF272CH274 el Fesder Dischange Chute | SCALFING SCREENING AREA PTWES KR T1 15/05/2017 11:00 AM | 16/05/2017 1100 AM |0 OFEN
100600604 BF364Instal Shutle In-posiion Proxy. BF364 Feeder Blect Instr Cortrol SECONDARY & TERTIARY CRUSHING AREA| TAS T2 15/05/2017 11:00 AM | 16/05/2017 300 FM |4 OFEN
100608020 AF151 - Preset Relef Valve Block AF151-HYO1 Feeder Hydrauic Power Pack | PRIMARY CRUSHING AREA CUST FP HYDRAULICS T1 | 21/06/2017 200 AM | 21/05/20176:00 AM |8 OFEN
100612714 CV361-GOT Repair Twisted Catenay CV361-MGDT Conveyor Magnet Assembly | SECONDARY & TERTIARY CRUSHING AREA| TAS T2 19/05/2017 6:30 AM | 19/05/2017 1030 FM |16 OFEN
100613165 BN361-Repiace Lower Bin Side Wals BN361 Feed Bin Assembly SECONDARY & TERTIARY CRUSHING AREA | PTWES HP T3 15/05/2017 11:00 AM | 16/05/2017 1200 PM |1 OFEN
100613551 CRC363- Replace Lube Pump 1 CRC363LUDT Crusher Lubrication System | SECONDARY & TERTIARY CRUSHING AREA| TAS T2 19/05/2017 1:00AM | 19/05/2017200PM |13 OPEN

3. Click Print Preview.

6.

6.1

End of Procedure

TEMPLATES EVENT

Create New Template Event

1. From the Main Login Screen. Select Event > New Event

C—

FMG Permit To Wark

Event el Settings  About  Online Discussion Board  Documentation
= Main |

K TN

—oEN

Mew Event |

Edit Event

ORTESCUE PERMIT TO WORK SYSTEM

mozshutdown
Shutdown

SY170PFDN

TestSHutdown

SY170PFN v
Event Type: Shutdown

= Breakdown
BreakdownEvert View Event
Mozbreakdown

- Templates
MasterTemplate
myTemplate UserMName: Cong
Role Level:  administrator
Access Llevel: 4

2. Enter the Event’'s name and select Templates
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Create New Event

Evert Name: |5ertdownTeranates

Event Description: |

Event Type: [ | Shutdown

[ Breakdown
Templates

3. Select the newly created event from the drop down list and Click on View Event to
continue

7.

7.1

ADMINISTRATION

End of Procedure

Add new Isolation Point

1. From the Event Details page. Click on Administration > Isolation Points Register

File éWulk Group

i, Administration | Audit Trail  Rfports
£ | P

Event Overview

Deocumentation -@ Help

ISOLATION STATEMEN| & Isolation Points Register |

NTS

Actions

| Lockbox Register

7| Import

[ PERMIT TO WORK

() WORK PACKS

=] WORK ORDERS

LockBox Coversheet

- %

SY170PF0145-000002

Short|D

JobDescription
SHUTDOWN W

FF01-15-000001

SHUTDOWN WORKS -

CreatedBy

§Z152 enguyen

52151 | cnguyen

GeneratedDate

Status
DRAFT

712:31 PM

26/04/2017 12:43 PM | DRAFT

Speciallnfo

Plant AreaName

LockBoxNumber

FMG-5M-CRUSHINGHUB |2

SY170PF01-15-000003

SHUTDOWN WORKS -

26/04/2017 1244 PM | DRAFT

FMG-5M-CRUSHINGHUB |3

2. A new Tag Register Form will popup. Click on New Tag

Import from Excel

Export to Excel

Edit

Update

~ | Search by |solation Point

Delete Selected Point

Delete All
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CRUSHINGHUB

AssstD

EquipmentID
APRON FEEDER 151

APRON FEEDEI

8 FMG-SM-CRUSHINGHUEB AF151 APRON FEEDER 151 AFRON FEEDEI
E FMG-SM-CRUSHINGHUEB AF151 APRON FEEDER 151 APRON FEEDEI
10 FMG-SM-CRUSHINGHUE AF151 APRON FEEDER 151 APRON FEEDEI
1 FMG-SM-CRUSHINGHUE AF151 APRON FEEDER 151 APRON FEEDEI
12 FMG-SM-CRUSHINGHUE AF151 APRON FEEDER 151 APRON FEEDEI
135 FMG-SM-FIRETAILOPF AF261 APRON FEEDER 261 APRON FEEDEI
140 FMG-SM-FIRETAILOPF AF261 APRON FEEDER 261 APRON FEEDEI
141 FMG-SM-FIRETAILOPF AF261 APRON FEEDER 261 APRON FEEDEI




3. Enter the Tag Details. Click OK to proceed

Clear Form

Plart Area:
Asset ID:

Asset Name:
Equipment 1D:
Equipment Name:
Isolation Paint:
lsolation Level:
Energy Source:
Cleary Labeled:

| FMG-5M-CRUSHINGHUB

End of Procedure

7.2 Verify Isolation Points

1. From Event Details page. Click Administration > Isolation Points Register

[&Adminisl ion | Audit Trail Reperts  Event Overview  Documentation 0 Help

53 1S0LATION STATEMEN| & Isolation Points Register

TS | L] PERMIT TO WORK | () WORK PACKS WORK ORDERS

. Lockbox Register

Actions :ﬁ Import

LockBox Coversheet < Yx

JobDescription
5HI

ShortlD
SY170PF01-S-000002 | SHUTDOWN WORKS - 52151

CreatedBy GenerstedDate Status Speciallnfo Plant Area Name Lock BoxMNumber
uyen L NG

cnguyen 26/04/2017 12:43 PM | DRAFT

SY170PF01-15-000003 | SHUTDOWN WORKS - CV151

2. Use the horizontal scroll bar t
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ool to scroll the page to the right
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Click on the checkbox for the points to be verified. This will auto populates the time and

user’'s name
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Lockable Drawings Comments Verfied VerifiedDate VerifiedBy

18/03/2017 6:09 AM [ Cong

18/03/2017 6:09 AM [ Cong

H|O|0|”|O0O|o|ooOE

26/04/2017 4:07 PM | Cong

A 2042017 407 P [ Cong

18/03/2017 6:09 AM | Cong

<[=l=[=[=[=[=<[=[=[=<[=[=<[=<[=<[=]=<[=<|=|=<[=<|=<]=]|=<
4]

1|0|0|0|/O0|=| 0| O|0|o|0|0

Click Update to make the change

o Mew Tag  Import from Excel  Exportto Excel Edit | Update | Delete Selected Point  Delete All
---Filter by Asset|D--- ~ | Search by |solation Point YX
me lsolationPoint lsolationLewvel Enengy®
FEEDER MOTOR 1 SR151-MCCO1-AF151-EMDD1 LV Blectrica
FEEDER MOTOR 2 SR151-MCCO1-AF151-EMO02 LV Blectrica
NG FAN 1 SR151-MCCO1-AF151-EM003 LV Blectrica
NG FAN 2 SR151-MCCO1-AF151-EMDD4 LV Blectrica
EATING SYSTEM SR151-MCCO1-AF151-HEDD1 LV Blectrica
DUST SUPPRESSION SUPPLY VALVE FIELD-AF151-VA1052 M Mechani
FEEDER POWER PAC SR102-MCCO1-AF261-HYD1 LV Blectrica
FEFAER O InE cweTE £MAAT REERY AT 11N e Flectioo

End of Procedure

7.3 Add Photo to Isolation Points

1. From Event Details page. Click Administration > Isolation Points Register

) Event

File éWolk Group

[&Admmlstratlon ‘ Audit Trail  Reports  Event Overview  Documentation QJ Help

ISOLATION STATEMEN( Isolation Points Register |LENTS 2] PERMIT TO WORK | () WORK PACKS | [5] WORK ORDERS
|- Lockbox Register Il
Actions |5 Import l‘m: LockBox Coversheet nJ YX
ShortID JobDescription CreatedBy GeneratedDate Status Speciallnfo Plant AreaName Lock BoxMNumber

PFO1-15-000001 SHUTDOWN WORKS 52 cnguyen
SY170PF01-15-000002 | SHUTDOWN WORKS - SZ151 | cnguyen
SY170PF01-15-000003 | SHUTDOWN WORKS - CV151 | cnguyen

712:31 PM DRAFT
26/04/2017 12:43 PM | DRAFT
26/04/2017 1244 PM | DRAFT

M-CRUSHINGHUE | 1
FMG-5M-CRUSHINGHUB | 2
FMG-SM-CRUSHINGHUB |3

2. Right-click a selected point > View Photo
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Isolation Point Matrix

igNewTog  Importfrom Excel  Exporttofxcel Edit  Updste  Delete Selected Point  Delete All
~--Filter by AssetiD-— - | Search by Isolation Paint X

Tagld  Plantfrea AssetlD Equipmert/D AssetName EquipmertName IsolationPoirt
143 FMG-SM-FIRETAILOPF AF262 APRON FEEDER 262 APRON FEEDER 262 AF262 APRON FEEDER MONO HOIST SRI02-MCCD1-AF262HO262
150 FMG-SM-FIRETAILOPF AF262 APRON FEEDER 262 aorsscncngs; AF262 APRON FEEDER BT CRANE SRID2-MCCD1-AF262.CN262

» -FIRETAILOPF BELT FEEDER VSD FEEDER
202 FMG-SM-FIRETAILOPF BF272 BELT FEEDER 272 E DERZP BF272 BELT FEEDER V5D FEEDER SRADIMCCO1-BF272
£l FMG-SM-FIRETAILOPF BF273 BELT FEEDER 273 BELT FEEDER 273 BF273 BELT FEEDER VSD FEEDER SR2DIMCCO1-BF273
768 FMG-SM-FIRETAILOPF BF273 BELT FEEDER 273 BELT FEEDER 273 FIELD-BF273 BELT CLAMP 1 FIELD-BF273 BELT CLAMP 1
769 FMG-SM-FIRETAILOPF BF273 BELT FEEDER 273 BELT FEEDER 273 FIELD-BF273 BELT CLAMP 2 FIELD-BF273 BELT CLAMP 2
70 FMG-SM-FIRETAILOPF BF273 BELT FEEDER 273 BELT FEEDER 273 FIELD-BF273 BELT CLAMP 3 FIELD-BF273 BELT CLAMP 3
[ FMG-SM-FIRETAILOPF BF273 BELT FEEDER 273 BELT FEEDER 273 FIELD-BF273 BELT CLAMP 4 FIELD-BF273 BELT CLAMP 4
2 FMG-SM-FIRETAILOPF BF274 BELT FEEDER 274 BELT FEEDER 274 FIELD - BF274 BELT CLAMP 1 FIELD - BF274 BELT CLAMP 1
[ FMG-SM-FIRETAILOPF BF274 BELT FEEDER 274 BELT FEEDER 274 FIELD - BF274 BELT CLAMP 2 FIELD - BF274 BELT CLAMP 2
i FMG-SM-FIRETAILOPF BF274 BELT FEEDER 274 BELT FEEDER 274 FIELD - BF274 BELT CLAMP 3 FIELD - BF274 BELT CLAMP 3
75 FMG-SM-FIRETAILOPF BF274 BELT FEEDER 274 BELT FEEDER 274 FIELD - BF274 BELT CLAMP 4 FIELD - BF274 BELT CLAMP 4
206 FMG-SM-FIRETAILOPF BF274 BELT FEEDER 274 BELT FEEDER 274 BF274 BELT FEEDER VD FEEDER SRADIMCCD1-BF274
252 FMG-SM-FIRETAILOPF BF361 BELT FEEDER 361 BELT FEEDER 361 BF361 HYDRAULIC MOTOR 1 SRIADIMCCO1-BFIGT-HYI-EMDT

Isolation Point Details

Energy Source:

Status Required:
Comments:
Drawings:

AF151 COOLING FAN 1
SR151-MCCO01-AF151-EM003
LV

Electrical, Mechanical

OFF

Add Photo

e oW rie

Select a Photo Then Click OPEN button located at the bottom right corner
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Equipment Name:

Isolation

Energy Source:

Isolation Point Details

BF271 BELT FEEDER VSD FEEDER

Point: SR203-MCCO01-BF271
Isolation Level: LV

Status Required: OFF
Comments:
Drawings:

Electrical, Mechanical

End of Procedure

Added Photo

7.4 Update Isolation Point Details

1. Open an Event, Click on Administration > Isolation Points Register

File g Work Group | || g3 Administration | Reports  Eve

Overview  Audit Trail  Documentation &g Help  Tools

(&4 ISOLATION STATE!

Actions ;a Import

“H . Isolation Points Register |

@ SPECIFIC ISOLATION REQUIREMENTS

. Lockbox Register
Training Competencies

ShortlD Job|

Options

PERMIT TO WORK

Date Status Specialinfo Lock BoxNumber Plant AreaName

2. Select the Plant Area from the drop down list
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3. Select an Asset ID to drill down the list further:

%) New Tag  Import from Excel Exportto Excel Edit Update Delete Selected P

[

PlartArea

4. Click on Edit

%) New Tag | Import from Excel Exportto Excel | Edit | Update Delete Se

an - (A |

TaglD PlantArea Asset|D Equipment|D AssetName Equ

3 523 IL1 AF601 Apron Feeder Apron Feeder  AF6
525 IL1 AFB01 Apron Feeder Apron Feeder | AFB
527 IL1 AFB01 Apron Feeder Apron Feeder | AFB
529 IL1 AFB01 Apron Feeder Apron Feeder | AFB

5. The grid will be coloured in RED to indicate that you are now in Edit Mode

) Isoation Point Matix - ol
o) NewTag  Import from Excel  Exportto Excel Edit Update Delete Selected Point  Delete All

] -l [5]| search by isotation Point A -

TaglD PlantArea AssetiD L D IsolationPoint IsolationLevel ClearlyLabeled StatusRequired Vufl:d

» 523 L AFE01 Apron Feeder Apron Feeder | AF601-PP606-EMO1 Apron Feeder Hydraulic Power Pack No 1| SR461 Tier 2F-10 |Bec Bectrical Y OFF Test/Try

525 L1 AF601 Apron Feeder Apron Feeder | AF601-HX602, Hydraulic Pump Cooling Fan No 2 SR461 Tier 3F-00 |Bec Blectrical b OFF Test/Try

527 L AF601 Apron Feeder Apron Feeder | AF601-DI601-EMO1 Dribble Conveyor No 1 SRA461 Tier 5F-00 |Bec Bectrical Y OFF Test/Try

Bec Blectrical ki OFF Test/Try

529 L1 AF601 Apron Feeder Apron Feeder | AF601-SP601B-Train Unloading Siury Pump SR461 Tier 4F-10

6. Double-click the cell and type in the change:

L1 ~ AF601 » | Search by Isolation Point
TaglD PlantArea AssetlD EquipmentID AssetName EquipmentName Iso
523 IL1 AF601 Apron Feeder Apron Feeder | AF601-PP606-EMO1 Apron Feeder Hydraulic Power Pack No 1 SR
525 IL1 AF601 Apron Feeder Apron Feeder | AF601-HX602, Hydraulic Pump Cooling Fan No 2 SR
> 527 IL1 AF601 Apron Feeder Apron Feeder  |4F601-DIB01-EMD1 Dribble Conveyor No 1| MAKE CHANGES HEREE] | SR«
529 IL1 AF601 Apron Feeder Apron Feeder | AF601-SP601B-Train Unloading Shumy Pump SR

7. Click Update to make the change
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1SOlation FOINT Iviatrix

oNewTag Import from Excel  Exportto Excel  Edit Delete Selected Point  Delete All

i

H AF601

~ | Search by Isolation Point

TaglD PlantArea AssetlD EquipmentID AssetName EquipmentName I
523 IL1 AF601 Apron Feeder Apron Feeder | AF601-PP606-EMD1 Apron Feeder Hydraulic Power Pack No 1 S?
525 IL1 AF601 Apron Feeder Apron Feeder | AF601-HX602, Hydraulic Pump Cooling Fan No 2 SE
> 527 IL1 AF601 Apron Feeder Apron Feeder  |\FB01-DI601-EMO1 Dribble Conveyor No 1_MAKE CHANGES HEREE]| SE
529 IL1 AF601 Apron Feeder Apron Feeder | AF601-SP601B-Train Unloading Slumry Pump s

End OF PROCEDURE

7.5

Duplicate Isolation Tag

1. To duplicate a Tag, Right-click a point. Select Duplicate

o New Tag  Import from Excel  Exportto Excel Edit Update  Delete Selected Point  Delet
lIL‘I Ij l Ij Search by Isolatic
TaglD PlantArea AssetD Equipment|D

IL1 AF601 Apron Feeder
527 IL1 AFB01 Apron Feeder  Apron Feeder | Duplicate |
529 IL1 AFB01 Apron Feeder Apron Feeder | AFB01-SPE01B-Train Unloa

2. New form will pop up, fill in the details and click OK

E

New lsolation Tags

Clear Form

Asset ID:
Asset Name:
Equipment 1D:

Plant Area:

Equipment Name:
Isolation Point:
Isolation Level:
Energy Source:

Cleary Labeled:
Status Required:
Verfication:

IL1 v/
AFS01 ]
Apron Feeder |
Apron Feeder ]
AF601-PPE06-EMO1 Apron Feeder Hydraulic Power Pack No 1 I
SR461 Tier 2F-10 |

Blec vl
Blectrical vl
v .
OFF v/
Test/Try vl
Y vl
|

| Concel |
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7.6 Add New Lock Box

1. From the Event Details Window. Click on Administration > Lockbox Register

File ﬁka Group

@ ISOLATION STATEME]

E*Adminislmiion Audit Trail  Reports  Event Overview  Documentation @ Help

?r, Isolation Points Register
. Lockbox Register J

ShortID Job Description CreatedBy GeneratedDate Status Speciallnfo

TS | L) PERMIT TO WORK | () WORK PACKS | [-] WORKORDERS

LockBox Coversheet = Yx

LockBoxMNumber PlantAreaName

GHUB
-CRUSHINGHUB
SY170PF01-15-000003 | SHUTDOWN WORKS - CV151 | cnguyen 26/04/2017 12:44 PM | DRAFT FMG-SM-CRUSHINGHUEB

2. Right-click an isolation Point > View Photo

3. A New window will popup. Click on New Lock Box

Mew Lock Box | Delete LockBox  Delete ALL  Edit  Export To Excel
LockBoxID LockBoxNumber

w e ~|o|[o|a]wn
w e~ @] a]w

=
=

I
I

P
P

=
=

&
&

ES
ES

3
3

&=
&=

4. Enter the Lock box details. Click SAVE to proceed
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LockBax Location: | Firetall OPF ]
Copies |- |[12 SAVE | | Cancel

LockBaxID LockBoxNumber  LockBoxLocation  LockBoxKeyNumbe
» m;_ﬁmmw

172 172 Firetail OPF

173 17 Firetail OPF

174 74 Firetail OPF

175 175 Firetail OPF

176 176 Firetail OPF

177 177 Firetail OFF

178 172 Firetail OPF

179 179 Firetail OPF

180 180 Firetail OFF

181 181 Firetail OPF

182 182 Firctail OPF
.

Note: you may also add custom lockbox names for example:

Double click on the LockBoxNumber Cell to edit

LockBax Location: | Firetail OPF |

LockBox Key Number: | |
o [ 1]
LockBoxID LockBoxNumber  |ockBoxLocation  LockFiaxKeyNumbe
171 HV/ABO1 retail OPF
172 HV/ABD2 retail OPF
173 HV/ABD3 retail OPF
174 HV/ABD4 retail OPF
HV/ABDS| retail OPF

End of Procedure
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